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ARAZİLERE SOLAR PANELLER DİZİSİNİN RÜZGÂR YÜKÜ ALTINDA 

SİMÜLASYONU 

(YÜKSEK LİSANS TEZİ) 

 

KHALED ADAMEH 

 

ÖZET 

Yenilenebilir enerji kaynaklarının kullanımı hızla artmaktadır. Bu eğilimin ardından, 

geniş alanlı güneş enerjisi sistemlerinin uygulanmasının bir zorunluluk olduğu 

düşünülmektedir. Maksimum toplam verimin elde edilmesi için taşıyıcı sistemlerin birkaç 

tasarım yaklaşımı sunulmuştur. Genelde aerodinamik kuvvetlerle yüklenir. Uluslararası 

yönetmelikler ve endüstriler arasındaki rekabet, büyük rüzgâr hızlarından kaynaklanan 

muazzam yüklere dayanmaları gerektiğini tanımlamaktadır. Ayrıca, 20 yıldan daha uzun bir 

ömürleri olmalıdır. Gerilme analizi taşıyıcı sistemleri optimize etmede önemli rol oynar. 

Bilgisayar tabanlı sonlu elemanlar yazılımındaki gelişmeler nedeniyle tasarım süreci, 

yapılanmış modellerin hızlı bir şekilde değiştirilmesi ve test edilmesini kolay simülasyon 

yöntemleriyle kolaylaştırmıştır. 

Bu çalışmadaki güneş sisteminin modeli, Şanlıurfa-Siverek ilçesinde yapılan elektrik 

üretim projesinden alınmıştır. Model, beton temeller ile araziye tespit edilmiş tek ayaklı bir 

taşıyıcı sisteme monte edilmiş 30° açıyla eğilmiş iki sıradaki 22 güneş panelinden oluşur. 

Arazi eğiminin güneş sisteminin davranışına etkisini incelemek için, model önce düz arazi 

üzerine daha sonra 10, 20, 30 derece ile eğilmiş arazilere yerleştirilmiş. Buna göre toplam 

yapısal analiz modeli sayısı dört olmuştur. İlk önce simülasyon Ansys Workbench 

programında 28 m/s rüzgâr hızlarında Spalart-Allmaras türbülans modeliyle Hesaplamalı 

akışkanlar dinamiği (HAD) yöntemi kullanılarak yapılmıştır. Simülasyon güneş panelleri 

üzerindeki basınç dağılımını elde etmek için HAD analizi ve daha sonra yapısal analizde bir 

yük olarak kullanılabilmek için basınç dağılımının Excel dosyası olarak çıkarılması 

içermiştir. Burada, enerji santrallerine yerleştirilen güneş panelleri üzerinde ardışıklığın 

etkisini göz önünde bulundurmak için, dört modelin her bir modeli için panellere arka arkaya 

beş sıra kadar eklenmiş ve toplam simülasyon modellerinin sayısı yirmi olmuştur. Son 

olarak, yapısal analiz sırasında güneş panellerine uygulanacak basınç yükü elde edildikten 

sonra, dört temel modelin doğrusal statik analizi yapılmıştır. 

HAD simülasyonu yapıldıktan sonra güneş panelleri üzerindeki basınç dağılımı elde 

edilmiştir; buradaki ilk güneş panelleri sırasının, rüzgârın bir sonraki sıralara ilerlemesini 
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önleyen bir rol oynadığı gözlemlenmiştir. Arazi eğiminin arttırılmasının, rüzgâr yükünü 

azalttığı da gözlenmiştir. Arazi eğimi arttıkça, her iki güneş paneli yüzeyindeki basınç pozitif 

hale gelmiştir. Diğer bir deyişle, panellerin arka yüzdeki basınç ön yüzdeki basıncı azaltarak

 direnç gösterir. Bu nedenle, panellerin yüzeyleri arasındaki basınç farkları daha 

düşük olur, bu da taşıyıcı sistem üzerinde daha düşük bir yük durumu anlamına gelir ki bunu 

da statik analizin sonuçlarıyla doğrulanmıştır (yer değiştirme, gerilme, güvenlik faktörü vb.). 

Anahtar Kelimeler: Ansys/Workbench Programı, Arazinin Eğim Açısı, Ardışıklık Etkisi, 

Doğrusal Statik Analizi, HAD Simülasyonu, Solar paneller 
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SIMULATION OF SOLAR PANEL'S ARRAY MOUNTED ON GROUND UNDER 

WİND LOAD 

(M.Sc. THESIS) 

 

KHALED ADAMEH 

 

SUMMARY 

The use of renewable energy resources is increasing rapidly. Following this trend, 

the implementation of large area solar arrays is considered to be a necessity. Several design 

approaches of the supporting structures have been presented in order to achieve the 

maximum overall efficiency. They are loaded mainly by aerodynamic forces. International 

regulations as well as the competition between industries define that they must withstand the 

enormous loads that result from large air velocities. Furthermore, they must have a life 

expectancy of more than 20 years. Stress analysis plays important role in optimizing the 

structure. Due to the advances in computer based finite element software’s design process is 

made simple by easier simulation methods fast replacing prototype built up and testing.  

In the current study, the model of the solar system was taken from the power 

generation project carried out in the Sanliurfa state in the city of Siverek. The model consists 

of 22 solar panels in two rows tilted at a 30° angle on the horizon and mounted on a single-

legged support structure installed on the ground with concrete bases. In order to study the 

effect of ground's inclination on the behavior of the solar system, the model was once placed 

on flat ground and again on inclined grounds with a tilt of 10, 20 and 30 degrees on the 

horizon. Accordingly, the total number of structural analysis models has become four.  

Firstly, the simulation was carried out in the Ansys Workbench program on wind speeds of 

28 m/s using the Computational fluid dynamics (CFD) method with Spalart–Allmaras 

turbulence model. The simulation includes the CFD analysis to get the pressure distribution 

over the solar panels and then extract the pressure distribution to use it as a load in the 

structural analysis. Here, to consider the effect of the consecutiveness on the solar panels 

placed in the power plants, up to 5 rows of panels were added behind each other for each 

model of the four models, bringing the total number of simulation models twenty. Finally, 

after obtaining the pressure load to be applied to the solar panels during the structural 

analysis, the linear static analysis of the four basic models was performed. 
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According to the CFD simulation were reached to the distribution of pressure on 

solar panels where observed that the first row of solar panels plays a role of impediment that 

prevents the wind from advancing towards the next rows. It was also observed that increasing 

the ground's tilt reduces wind load. As the ground's tilt increases, the pressure on both solar 

panel faces becomes positive. That is, the pressure on the back of the panels will resist the 

pressure on the front face in an attempt to reduce it. Thus, lower pressure differentials 

between the sides of the panels, which means a lower load state on the supporting structure 

and this has been confirmed by the results of the static analysis (deformation, stress, safety 

factor, etc.). 

Key words: Ansys / Workbench Program, Ground's Tilt Angle, Consecutiveness Effect, 

Linear Static Analysis, CAD Simulation, Solar Panels 
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1 GİRİŞ 

1.1 Güneş Enerjisi 

Kullandığımız enerjinin çoğu, yavaş yavaş tükenmekte olan petrol, gaz ve kömür 

gibi fosil yakıtlardan gelmektedir. Bu yakıtların kullanılması havayı kirletir ve karbondioksit 

üretir. Bu şartlarda yaşamaya devam etmek istiyorsak, daha temiz ve daha yeşil yakıt 

kaynaklarına bilindiği üzere "yenilenebilir enerji" geçmemiz gerekmektedir. Güneş enerjisi 

tartışmasız bilinen en iyi yenilenebilir enerji kaynaklarından biridir. 19. yüzyılda, kömürün 

tükeneceğini anlayan insanlar güneş enerjisi ile ilgilenmeye başladılar. Ayrıca artan çevre 

bilinciyle insanlar güneş enerjisi gibi daha temiz enerjiler aramaya başladılar. Genelde güneş 

enerjisi iki temel türü vardır: 

▪ Fotovoltaik (PV): Bunlar en yaygın şeklidir. Her hücre güneş ışığını elektrik 

enerjisine dönüştürür ve daha sonra elektrikli cihazlara güç sağlamak için kullanılır 

(Bkz. Şekil 1.1). 

 

 

Şekil 1.1 Fotovoltaik panellerin genel şekli 

▪ Konsantre Güneş Enerjisi (CSP): PV'ye benzer görünebilir, ancak farklı şekilde 

çalışırlar. Yoğunlaştırılmış güneş ışığı ayna sisteminden yansıtılır. PV ışıktan, CSP 

ısıdan enerji üretir (Bkz. Şekil 1.2). 
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Şekil 1.2 Konsantre güneş enerjisinin türleri 

1.2 Güneş Enerjisi Sistemleri (GES) 

Güneş enerjisi sistemi, birkaç fotovoltaik (PV) panelden ve PV panellerini yerinde 

tutan çelik profillerden oluşur. Güneş Fotovoltaik (PV) paneller genellikle çatıya veya 

araziye monte edilir. Paneller güneşin aktif yönüne yönlendirilmeli ve panellere çarpan 

güneş ışığı miktarını en üst düzeye çıkarmak için belirli açılarda yatırılmalıdır. PV 

sistemleri; çatılara monte edilen küçüğünden, enerji üretim tesislerinde monte edilen 

büyüğüne kadar farklı büyüklüklerde olabilir. 

Her PV sistemi, yapısı ve montaj tipleri açısından diğerlerinden farklıdır. Bunun 

nedeni, PV sistemlerinin alan kısıtlı olması ve montaj gereksinimlerinin yerden yere 

değişmesidir. Bu nedenle yere, direğe ve çatıya montaj gibi farklı ihtiyaçları karşılamak için 

birçok yapısal çözüm geliştirilmiştir. Her türün, iyi bir tasarımcının her belirli PV sistemi 

için en uygun kararı vermesini sağlayan avantaj ve dezavantajları vardır. Güneş enerji 

sistemleri (GES) genel anlamda ikiye ayrılıyor denilebilir. 

1.2.1 Arazi uygulamalı GES  

Arazi uygulamalı GES’ler için en büyük problemlerin başında tarıma elverişli 

olmayan, uygun açıya sahip, gölgelenmeyen, güneye bakan bir arsa bulunması, ikinci önemli 

sorun da şebekede gerekli kapasitenin olmaması oluyor. Eğer bu iki sorun aşılıp da bağlantı 

izni alınabilirse teknik anlamda yapılacak iş çok basit denilebilir 1.  



3 

 

 

Arazi uygulamalı GES’lerin taşıyıcı sistemi için çoğunlukla soğukta şekillendirilmiş 

C profiller kullanılmaktadır. 3-5 mm arasında kalınlığa sahip bu profiller zeminin 

uygunluğuna göre çakılabilir veya betonarme temellere oturabilirler. 

Bu tip, Şekil 1.3'te gösterildiği gibi çoklu modül dizilerinin yere monte edilmesini 

sağlar. Yere monte PV panelleri, birim başına modül sayısına bağlı olarak yere dayalı montaj 

yapısına bağlı aşıklar veya çerçeveler tarafından tutulan PV Modüllerinden oluşur. 

Geliştirilen her yapı iyi bir optimizasyon ve uyarlamanın karışımıdır, yani bu yapılar her 

türlü PV modülüne uyacak şekilde özelleştirilebilir ve değişen çeşitli toprak tipleri için 

optimize edilebilir. Modüllerin düzenlemesi Yatay veya Dikey Yönde olabilir. Ayrıca 

Bakım ve havalandırmayı kolaylaştırmak amacıyla paneller yerden 0,5 ila 1,5 m yüksekte 

kurulmalıdır 2. 

 

 

Şekil 1.3 Arazi uygulamalı bazı GES türleri 

Avantajlar; 

▪ Soğutucu modül sıcaklığı. 

▪ Güvenli kurulum. 

▪ Bakım / sorun giderme için kolay erişim. 

▪ Çatı penetrasyonu (nüfuz) yok. 

▪ Maksimum üretim için esnek konumlandırma. 
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Dezavantajlar; 

▪ Kolay erişim (Hırsızlık, Vandalizm, Hasar). 

▪ Taban yapım işi gerektirir (Beton, Temel, Hendek açma). 

▪ Mekân gereksinimi. 

▪ Sıralar arası gölgeleme hususları, PV modülleri sıralara takıldığında birbirlerini 

gölgeleyebilir. 

1.2.2 Çatı uygulamalı GES 

Çoğu binada çatı kullanılmayan alan olarak kabul edilir. PV dizisi bu alanları 

kullanabilir ve bina için elektrik üretebilecek yararlı alanlara aktarabilir. Çatı uygulamalı 

güneş enerjisi sistemleri, aşıklar veya çerçeveler ile yerinde tutulan güneş panellerinden 

oluşur. Mevcut bir yapı üzerine yapılması planlanıyorsa normal şartlarda o yapının 

tamamının performans analizi yapılarak üzerine gelecek bu ilave yükü taşıyıp taşımadığı 

değerlendirilmelidir 1. 

1.3 Güneş Panelleri ve Rüzgâr Yükü 

GES Yapıları fiziksel ve iklimsel şartlardan dolayı sürekli bazı yüklere maruz 

kalırlar. Bu yüklerden en önemlisi rüzgâr yüküdür. Panellerin diğer boyutlarına göre geniş 

yüzeyleri nedeniyle rüzgâr yükünün bunlara etkisi büyük olacaktır. Bu nedenle rüzgâr 

yüküne karşı güneş panellerinin yapısını incelemek ve analiz etmek önemlidir. 

Rüzgâr yükleri üzerinde deneysel veya sayısal araştırma çalışmaları yapmak için, 

belirsizliklerin çok yüksek olduğu meteorolojik koşullar, atmosfer ve yeryüzü yapısının göz 

önünde bulundurarak ayrıntılı bir çalışma yapılması gerekmektedir (Holmes, 2001). Rüzgâr 

yüklerinin yapılar üzerindeki etkileri, aşağıdaki yapısal kategori türlerine göre 

değişmektedir: 

▪ Az katlı binalar 

▪ Yüksek binalar (münferit olarak veya diğer yapılarla birlikte) 

▪ Büyük çatılı yapılar: stadyumlar, havaalanları vb. 

▪ TV ve radyo kuleleri, bacalar gibi hassas yapılar. 

▪ Köprüler. 

▪ Elektrik iletim hatları. 

▪ Diğer yapılar: duvarlar, çatılar, mevcut binalara yeni eklemeler vb. 
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Her yapı şekli ile benzersizdir, bu nedenle benzersiz geometri rüzgâr yüklerinin 

değişken etkilerine neden olur. Bazen rüzgâr yüklerinin belirlenmesi, problemin multifizik 

analizini gerektiren titreşimlerin katılımı ile daha zor olur. Amerikan İnşaat Mühendisleri 

Birliği’nin "Binalar ve Diğer Yapılar için Minimum Tasarım Yükleri" yönetmeliği (ASCE, 

2010) yukarıda listelenen yapılar için en önemli ve ayrıntılı rüzgâr yükü hesaplamalarından 

birini içerir. Avrupa Birliği de rüzgâr yükü hesaplamaları ile ilgili "Eurocode-1 (EN 1991-

1-4, 2004)" olarak adlandırılan bir yönetmelik yayınlamıştır. Önceki belgeler dışında, birçok 

ülkelerin, kurumların ve şehirlerin bile ek yönetmelikleri vardır. Türkiye'de yapılardaki 

rüzgâr yüklerini belirlemek için "TS498- Yapı Elemanlarının Boyutlandırılmasında 

Alınacak Yüklerin Hesap Değerleri" 'nin yönetmeliği kullanılır ancak, bu yönetmeliğin 

yukarıdaki belirtilen kategorileri kapsaması bakımından yetersiz olduğu iddia edilmektedir 

3. Avrupa ve Kuzey Amerika standartları daha ayrıntılı bir şekilde hazırlanmasına rağmen, 

bu yönetmeliklerde güneş enerjisi santrallerinde yerleştirilen panellere etkiyen rüzgâr 

yüklerinin belirlenmesi ile ilgili hiçbir şey yoktur 3. 

Güneş panelleri için en uygun rüzgâr yükü hesabı; “açık binalar / tek yönde eğimli 

serbest çatılar” adı altında Amerikan İnşaat Mühendisleri Birliği’nin yönetmeliğinde 

bulunur. Bununla birlikte, güneş panelleri tek bir eğimli çatıdan sadece geometrik şekil, 

kullanım ve PV panellerin maliyeti açısından değil, aynı zamanda bu panellerin bir güneş 

enerjisi santrallerinin içine ardışık ve sık yerleştirilmesi bakımından da çok farklıdır. 

Panellere etkileyen rüzgâr yüklerinin belirlenmesinde; yerden net yükseklik, panellerin 

uzunluğu ve genişliği, eğim açısı, ardışık yerleştirilen panellerin aralıkları ve paneller 

arasındaki açıklık rüzgâr yüklerinin seviyesini etkiler. Ayrıca Şekil 1.4'te görüldüğü gibi 

rüzgâr yönünün de etkisi vardır. 
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Şekil 1.4 Güneş paneli üzerindeki rüzgâr  basınç dağılımı,  

(a) rüzgâr  yönü panel ön yüzüne (b) rüzgâr  yönü panel arka yüzüne 4 

Geniş yüzey alanı göz önüne alındığında bu modüller üzerine aynı anda etki eden 

rüzgâr kuvvetleri bu sistemlerde ciddi mekanik sorunlara neden olabilir. Bu nedenle, rüzgâr 

akışını ve panellerle etkileşimini iyi anlamak potansiyel zararları en aza indirmek için çok 

önemlidir. Uluslararası yönetmeliklerin yanı sıra endüstriler arasındaki rekabet, güneş 

sisteminin 120 km/s üzerindeki hava hızlarından kaynaklanan muazzam yüklere dayanması 

gerektiğini tanımlamaktadır. Ayrıca, 20 yıldan daha uzun ömürlü olmalıdır 5. 
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2 ÖNCEKİ ÇALIŞMALAR 

Güneş panelleri üzerine etkileyen rüzgâr yüklerinin belirlenmesi ile ilgili birçok 

araştırma ya da çalışma yapılmasına rağmen şimdiye kadar, basınç dağılımı mekanizmasını 

belirlemek için belirli bir yaklaşıma ulaşılmamıştır. Burada, bu alanda bazı yapılan 

çalışmalardan bahsedilmiştir. 

Chevalier, H L ve Norton, D J (1979) tarafından yapılan "wind loads on güneş 

collector panels and support structure" başlıklı çalışma çatıya monte güneş panelleri ve 

taşıyıcı yapıları için rüzgâr yükü sorununu ele almaktadır. Amaç, çeşitli biçimler ve rüzgâr 

koşulları için oluşan kuvvet ve moment katsayılarını sağlamaktı. Çalışma sonucunda, 

rüzgârın estiği yöndeki dizilerin paneli, tek duran eşdeğerli panelden daha az kuvvet aldığını 

gözlemlenmiştir. 

Peterka, Sinau ve Cermak (1980) tarafından yapılan "mean wind forces on parabolic-

trough güneş collectors" başlıklı çalışmanın amacı, rüzgâr çiti olan ve olmayan parabolik 

yalak güneş kolektörlerinin çeşitli biçimlerinde ve çevresinde hava akımı tarafından üretilen 

ortalama rüzgâr yüklerinin özelliklerini araştırmaktı. Bu çalışmada çeşitli hâkim 

değişkenlerin etkileri incelenmiştir: rüzgâr -azimut, yalak yüksekliği açısı, dizi alanı 

düzenlemesi ve rüzgâr çiti özellikleri. 

Son on yılda, araştırmacılar çatı uygulamalı güneş panellerine daha fazla 

odaklanmışlar. Kopp, Surry ve Chen (2002), farklı açılardan etkileyecek rüzgârlar nedeniyle 

panellerin köşelerinde ve kenarlarında oluşturulan girdap etkileri üzerine deneyler yapmıştır. 

Binaların çatısına yerleştirilen güneş enerjili su ısıtıcılarına etki eden şiddetli tropik 

fırtınaların etkisini azaltmak için, Chung, Chang ve Liu (2008) kaldırma kuvvetlerini 

azaltmak için deneysel çalışmalar yürütmüşlerdir. 

Mihailidis, Panagiotidis ve Agouridas (2009) "analysıs of solar panel support 

structures" başlıklı bir araştırma sundu. Bu çalışmada, güneş paneli taşıyıcı yapılarının iki 

farklı tasarım yaklaşımının analizi sunulmuştur. Birincisi belirli bir konuma monte edilmiş 

sabit sistem diğeri ise iki eksen etrafında otomatik olarak döndürülmesini sağlayan 

mekanizmalara sahip ayarlanabilir bir sistemdir. 

Başka bir çalışmada, Bitsuamlak, Dagnew ve Erwin (2010), yere montaj güneş 

panelleri üzerinde hesaplamalı akışkanlar dinamiği analizi yapmışlar. Bu çalışmada, güneş 

panellerine etkileyen rüzgâr basıncının 180˚ rüzgâr yönünde maksimum olacağını bulunmuş 
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ve ardışık panellerin yerleştirilmesi de incelenmiştir. Bu çalışmanın en önemli sonucu, ilk 

sıra panelin diğer diziler üzerinde korunaklılık etkisi sağlamasıydı. 

Kopp (2013) farklı rüzgâr yönü açısının etkisinin ve az katlı bina çatılarının üzerine 

yerleştirilmiş panellerin ardışık yerleştirilmesinin etkisini incelemiştir. Diğer çalışmalardan 

farklı olarak, Schellenberg, Maffei, Telleen ve Ward (2013), rüzgâr yüklerinin titreşimli 

etkisi altında güneş panellerinin doğrusal olmayan yapısal davranışını belirlemek için zaman 

serisi davranış analizi yapmışlardır. 

Maffei, Telleen, Ward, Kopp ve Schellenberg (2014), düşük eğimli çatılara 

yerleştirilmiş güneş panelleri için öneriler sunmuşlar. ASCE 07/10 yönetmeliğinin, çatılara 

yerleştirilen güneş panellerine etkileyen rüzgâr yüklerinin hesaplanmasında rehberlik 

sağlama açısından yetersiz olduğunu bildirmişlerdir. 

Hong Li, Dongxu Zhang, Zhongwen Qin, Li Li ve Enguo Zhang (2015), "analysis of 

deformation and strength of güneş module support under wind-wave load" başlıklı bir 

araştırma sundu. Bu çalışmadaki PV yapısı modülünün tasarımı, güverte üzerindeki şiddetli 

rüzgâr yükleri ve dalga yükleri altındaki deniz ortamı için uygundur. 

Raghuvendra Singh Som, Rishabh Sharma ve Harshit Tripathi (2016), "stabılıty and 

stress analysıs of solar array structure" başlıklı bir araştırma sunmuştur. Bu çalışmada, güneş 

paneli üzerindeki basınç dağılımını belirlemek için ön işlemci olarak ANSA ve çözücü 

olarak ANSYS-CFX kullanılarak hesaplamalı akışkan dinamiği (HAD) basit bir modelinin 

oluşturulmasını içeren yük hesaplama analizi yapılmıştır. 

Kao-Chun Su ve Kung-Ming Chung (2018) "numerical simulation of wind loads on 

güneş panels" başlıklı bir araştırma sundu. Bu çalışma, hesaplamalı akışkan dinamiğini 

(HAD) kullanarak güneş panellerindeki rüzgâr yüklerini araştırmayı amaçlamaktadır. Dört 

en-boy oranlı güneş panellerine etkileyen rüzgâr kaldırma kuvvetleri değerlendirilmiş. Bir 

güneş panelinin eğimli açısının ve açıklığının (veya yüksekliğinin) etkisi ele alınmıştır. 

Rüzgârın, güneş panelleri ve taşıyıcı yapılar üzerindeki etkisi ile ilgilenen, düz arazi 

uygulamalı pek çok GES çalışması incelendikten sonra, bu tür projelerin bazı şartlara ihtiyaç 

duyduğunu belirtmiştir: 

▪ Geniş alanlar. 

▪ Bu alanlar tarımsal kullanım için uygun olmamalı. 

▪ Alan güneşe açık olmalı. 

Bununla birlikte, bilimin gelişimi sayesinde toprak geri dönüştürülebilir ve tarım için 

kullanılabilir. Ayrıca, arıtma tesisleri ve konutlar gibi düz olmayan arazilerde uygulanması 
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zor olan projeler için düz arazilerin kullanması daha uygun görülmektedir. Bu nedenle, bu 

çalışmada yayla ve dağ etekleri gibi düz olmayan alanlara uygulanan güneş panelleri 

sistemini incelenmiştir. Bu araziler güneş ışığına maruz kalan geniş alanlara ve düşük 

yatırımlara sahiptir. Bu arazilerde böyle projelerin uygulanması, sadece düz arazilerde 

uygulanabilecek diğer projeler için daha fazla alan sağlayacaktır. Ek olarak, düz olmayan 

arazilerde güneş sistemi uygulaması maliyeti daha uygun olabilir. Düz olmayan arazi 

uygulamalı güneş sistemlerindeki rüzgâr yükünü azaltabileceği ve dolayısıyla rüzgâr 

kuvvetlerine karşı daha fazla dirence sahip olabileceği düşünülmektedir. 

Bu çalışmada, Şanlıurfa ilinde bulunan düz arazi uygulamalı bir güneş taşıyıcı yapısı 

alınmıştır ve düz olmayan bir araziye yerleştirdikten sonra inceleyerek yürütülmüştür. 

Ayrıca düz ve düz olmayan arazilere uygulanan güneş yapısını rüzgârın etkisiyle analiz 

ederek yapının istikrarı ve dayanıklılığı karşılaştırılmıştır. 
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3 HESAPLAMALI AKIŞKANLAR DİNAMİĞİ VE TÜRBÜLANS MODELLERİ 

3.1 Temel Kavramlar 

Analiz programlarını kullanırken verilerin doğru şekilde girilmesi elde edilecek 

sonuçlarında doğru olmasını sağlayacaktır. HAD programlarını kullanırken sınır şartları 

veya akış değerleri uygun şekilde girilmemişse veya sonlu elemanlara uygun olmayan bir 

şekilde bölünmüşse analizler sonucunda elde edilecek veriler doğru olmayacaktır. Bu 

sebeple doğru sonuçları elde etmek için verilerin doğru ve uygun girilmesi şarttır. 

Akışın var olduğu sistemlerin analizini yaparken deney ve bilgisayar tabanlı 

hesaplama olmak üzere iki yöntem kullanılmaktadır. Deney aşamasında rüzgâr tünelleri 

içerisindeki sistem üzerine hava şeklinde akışkan gönderilerek akışkanın sistem üzerindeki 

etkisi ölçülmektedir. Bilgisayar tabanlı hesaplama kısmı ise sistemin çözümlemesinde 

kullanılan diferansiyel denklemlerin analitik veya sayısal olarak çözülmesi ile elde edilen 

sonuçlarıdır. 

Bilgisayar programlarının geliştirilmesiyle HAD programlarından elde edilen 

sonuçlar deneylerden elde edilen sonuçlarla uyumludur. Bu sebeple HAD programları 

sayesinde deney sayısının azaltılarak deneysel olarak incelenmesi zor, pahalı, imkânsız olan 

endüstriyel koşulların analizi için iyi bir yöntem sağlanmaktadır 6. 

3.2 Hesaplamalı Akışkanlar Dinamiğinin Çözüm Adımları 

HAD analizi yaparken akışın olduğu bölge belirlenmektedir. Burada üçgen dörtgen 

şekillerinde iki boyutlu bölgeler için alan olarak, üç boyutlu bölgeler için hacim olarak ağ 

yapısı oluşturulmaktadır. Her ağ hücresi korunum denklemlerinin çözüldüğü yapılar olarak 

düşünülebilir. Bu hücreler ne kadar küçükse yapılan analizden alınacak sonuçların da o 

oranda doğruluğu yüksek olmaktadır. 

HAD analizi yaparken dikkat edilmesi gereken diğer bir husus çözümleme yapılacak 

kontrol hacminin sınır şartlarının programa girilmesidir. Başlangıç ve sınır şartları değerleri 

girildikten sonra oluşturulan her bir ağ hücresi için, hangi çözüm metodu kullanılacaksa 

(Spallart-Allmaras, k-ε, k-ω, Reynolds Stress) program bu denklemleri iteratif (tekrarlı) 

olarak çözer. Navier-stokes denklemlerinde eşitliğin her iki tarafı birbirine eşit olmalı başka 

bir deyişle eşitliğin her iki tarafı toplanması durumunda sonuç “0” çıkmalıdır. Lakin HAD 
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simülasyonu çözümünde iterasyon sonuçları toplamı sıfır olmaz ancak ilerleyen 

iterasyonlarda sonuç sıfıra çok yakın olacaktır 7. 

3.2.1 Ağ yapısının oluşturulması 

Hesaplamalı akışkanlar dinamiği çözümlemesinde kullanılan programlarda dikkat 

edilmesi gereken sınır değerleri doğru şeklinde girilmelidir. Program girilen bu değerlere 

göre geometriyi sonlu elemanlara ayıracak ve iterasyonla çözümleme yapacaktır. 

HAD programları genellikle iki ağ türü ile modelleri çözmektedir. Bunlardan biri 

yapılandırılmış diğeri ise yapılandırılmamış ağdır 8. 

3.2.1.1 Yapılandırılmış bir ağ 

Dört kenarlı düzlemsel hücrelerden (iki boyutlu) veya altı yüzlü (üç boyutlu) 

hacimsel hücrelerden oluşmaktadır. Hücrelerin dikdörtgen şekilleri bozulabilir ancak tüm 

hücreler mutlaka i-j-k indekslerine göre numaralandırılmaktadır. 

3.2.1.2 Yapılandırılmamış bir ağ 

Değişik şekillerde hücreler oluşmaktadır. Ancak genelde üçgen/dörtgen iki boyutlu 

şeklinde düzlemsel hücreler veya dörtyüzlü/altıyüzlü üç boyutlu hacimsel hücreler 

kullanılmaktadır. Bu iki ağ arasında çeşitli farklılıklar vardır. Bunların arasındaki önemli 

farklardan biri yapılandırılmış bir ağ, yapılandırılmamış bir ağdakine göre daha az sayıda 

hücrelere sahiptir. Akış değişkenlerinin çepere dik olarak çok hızlı değiştiği ve çeper 

civarında yüksek çözünürlüklü ağların gerektiği sınır tabakada, aynı sayıda hücre için, 

yapılandırılmış ağ yapılandırılmamış ağdan daha iyi çözünürlük sağlar. 

3.2.2 Sınır şartları 

Hesaplamalı akışkanlar dinamiğinde doğru sonuçları alabilmek için sınır şartlarının 

doğru ve eksiksiz girilmesi gerekmektedir. Sınır şartları ne kadar doğru tanımlanırsa elde 

edilecek sonuçların da doğruluğu o kadar yükselecektir. 

3.2.2.1 Duvar şartları  

Duvar sınır şartları belirlenirken hızın normal bileşeni ve teğetsel hızın bileşeninde 

kaymama koşulu nedeniyle sıfırdır. Çözümlemede türbülans modeli kullanılırsa, türbülans 

transport denklemi çözülür ve türbülanslı sınır tabaka çeper pürüzlülüğü hesaplanarak 
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çözümlemelidir. Bunun için bu çalışmada tüm güneş panellerinin yüzeyleri hava küpünün 

yanal yüzeyleri sabit duvar olarak tanımlanmıştır. 

3.2.2.2 Giriş ve çıkış sınır şartları 

Çözümleme yaparken akışkanın hava küpünün içerisine giriş (inlet) ve çıkışlarının 

(outlet) nasıl gerçekleştiği önemlidir. Bu nedenle akışkanın hız etkisiyle sisteme girse; girişi 

“velocity inlet” şeklinde, çıkışı “pressure outlet” şeklinde olmalıdır. Hareket denklemleri hız 

ve basınca bağlı olduğu için bir değer belirtilirken diğeri belirtilmez. Örneğin hız girişinde 

yalnızca hız değeri girilir basınç değeri belirtilmez. Çıkışta ise basınç belirtilirken girişte hız 

belirtilmez. İki değerin belirtilmesi yoğun matematiksel tanımlamaya sebep olur. 

3.2.2.3 Diğer sınır şartları 

Çözümleme bölgesinde bazı yüzeyler giriş veya çıkış sınır şartlarını karşılamayabilir. 

Simetri sınır şartı sayesinde akış alanı değişkenlerinin, simetri düzeyinin karşısında benzeş 

görüntüleri oluşturulur. Çözümleme esnasında simetrik olarak kabul edilen yüzeyler için 

sınır şartları bu yüzeylere dik yöndeki çoğu akış alanı değişkenlerinin gradyenleri simetri 

düzleminde sıfır alınır. Bu tür bölgeler genellikle simetrik yüzey olarak tanımlanır. 

3.3 Navier-Stokes Denklemleri 

Akış problemlerini yöneten Navier-Stokes denklemler en genel halde üç denklemden 

oluşur; süreklilik denklemi, momentum denklemi ve enerji denklemidir 9. 

Süreklilik denklemi vektörel formda: 

 
𝜕𝜌

𝜕𝑡
+ ∇(𝜌𝑉⃗ ) = 0 (3-1) 

şeklinde yazılabilir. 

Veya materyal türev kavramı kullanılarak 

 
𝐷𝜌

𝐷𝑡
+ 𝜌 ∇(𝑉⃗ ) = 0 (3-2) 

şeklinde yazılabilir. 

Momentum denklemi en genel hali vektörel formda 

 𝜌
𝐷𝑉⃗ 

𝐷𝑡
= 𝜌f − ∇𝑝 + ∇. 𝜏 (3-3) 
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şeklinde yazılabilir. Burada f vektörü bünye kuvvetlerini ifade etmektedir. Elektromanyetik 

etki ya da yer çekimi etkisinden gelmekte ve hava ile ilgili akış problemlerinde genelde ihmal 

edilir. 𝜏 ise viskoz gerilmeleri belirlemektedir. Hız bileşenleri cinsinden genelde 

 𝜏𝑖𝑗 = −𝛿𝑖𝑗

2

3
 𝜇 . ∇ . 𝑉⃗ +  𝜇 [

𝜕𝑢𝑖

𝜕𝑥𝑗
+

𝜕𝑢𝑗

𝜕𝑥𝑖
] (3-4) 

şeklinde tanımlanmaktadır. Burada 𝛿𝑖𝑗 Kronecker deltası olup değeri 

 𝛿𝑖𝑗 = {
1    𝑖 = 𝑗    𝑖ç𝑖𝑛
1    𝑖 ≠ 𝑗    𝑖ç𝑖𝑛

 (3-5) 

şeklinde belirlenir. 

Enerji denklemi genellikle aşağıdaki şeklinde yazılır: 

 𝜌
𝐷ℎ

𝐷𝑡
−

𝐷𝑝

𝐷𝑡
= Φ − ∇. 𝑄̇ (3-6) 

burada h,Φ ve Q büyüklükleri sırasıyla entalpiyi, dissipasyonu (tersini olmayan viskoz işten 

oluşan kayıp fonksiyonunu) ve ısı transferini temsil eder ve aşağıdaki gibi tanımlanır: 

 
ℎ = 𝑒 +

𝑝

𝜌
 

 

(3-7a) 

 

Φ =  𝜇 [2 (
𝜕𝑢

𝜕𝑥
)
2

+ 2(
𝜕𝑣

𝜕𝑦
)
2

+ 2 (
𝜕𝑤

𝜕𝑧
)
2

+ (
𝜕𝑢

𝜕𝑦
+

𝜕𝑣

𝜕𝑥
)
2

+ (
𝜕𝑣

𝜕𝑧
+

𝜕𝑤

𝜕𝑦
)
2

+ (
𝜕𝑤

𝜕𝑥
+

𝜕𝑢

𝜕𝑧
)
2

]

−
2

3
𝜇 [

𝜕𝑢

𝜕𝑥
+

𝜕𝑣

𝜕𝑦
+

𝜕𝑤

𝜕𝑧
]
2

 

 

 

 

 

 

(3-7b) 

 𝑄̇ =  −𝑘∇ . 𝑇 (3-7c) 

Genelde problemlerde herhangi bir kimyasal reaksiyonu ya da ısı kaynağı varsa (3-

6) denkleminin sağ tarafına bu durum belirten ve hesaba katan bir 𝑆ℎ teriminin eklenmesi 

gerekmektedir 10. 

3.4 Türbülans Modelleri 

Üç yöndeki hız bileşenlerinde sürekli ve periyodik olmayan çalkalanma hareketine 

türbülans adı verilmektedir. Akışın atalet kuvvetleri viskoz kuvvetlerinden yeterince fazla 
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olduğu zaman türbülanslı akışlar oluşur, diğer bir deyişle akış bölgesinin her noktasında ani 

hızın çalkalanmasıdır. Türbülans akışı karakterize etmektedir. Diğer bir deyişle türbülans 

akışkanın bir özelliği değildir. Türbülanslı akışkanlar çalkalanan hız alanıyla karakterize 

edilir. 

Bu çalkantılar momentum, enerji ve  derişme tipleri gibi taşınan niceliklerin 

karışımıdır. Onların küçük ölçek ve yüksek frekansta olmasından dolayı direkt olarak pratik 

mühendislik hesaplarında simüle edilmesi matematiksel olarak oldukça pahalıdır. Ana 

denklemleri kullanmak yerine denklemler üzerinde birkaç değişiklikler yaparak hesaplama 

maliyeti ve çözümleme olayı azaltılabilir. Ancak değiştirilmiş bu denklemler ek bilinmeyen 

değişikler içerecek ve türbülans modelleri bu bilinmeyen değişikleri bilinen nicelikler ile 

hesaplayacaktır 10.  

ANSYS programındaki FLUENT yazılımı aşağıdaki türbülans modellerini 

kullanmaktadır 11. 

1. Spalart-Allmaras (Tek denklemli) 

2. 𝑘 − 𝜀 Modelleri (İki denklemli) 

▪ Standard k–ε (SKE) model 

▪ Renormalization group (RNG) k–ε model 

▪ Realizable k–ε (RKE) model 

3. 𝑘 − 𝜔 Modelleri (İki denklemli) 

▪ Standard k–ω (SKW) model 

▪ Shear Stress Transport k–ω (SSTKW) model 

4. Reynolds Stress Modeli (RSM) (Beş Denklemli) 

5. Detached Eddy Simulation Modeli (DES) 

6. Large Eddy Simulation Modeli (LES) 

Her akışın farklı başlangıç ve sınır şartları vardır. Ancak bütün türbülans 

durumlarında kullanılabilecek yetenekte kabul edilmiş bir türbülans modeli yoktur. Bu 

nedenle de mevcut türbülans modellerinden birinin seçilmesi gerekmektedir. Türbülans 

modelinin seçimi simülasyon için gerekli zamana, doğruluk seviyesine, elde edilebilen 

kaynaklara ve akımın çevresine bağlıdır. Uygulamalar için uygun modeli, hangi limit ve 

kapasitede olduğunu bilmekle seçilecektir. 

Türbülanslı akışlarda hızın zamanla değişimi Şekil 3.1'de gösterilmektedir. Ani hızı çalkantı 

hızıyla bir ortalama hızın toplamı ile belirtilebilir. Yani akımın herhangi bir noktasındaki hız 
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bileşenleri için 𝑢 = 𝑢̅ + 𝑢́ , 𝑣 = 𝑣̅ + 𝑣́  olarak yazılabilmektedir 12. Burada 𝑢̅ , 𝑣̅  sırası ile 

x ve y yönlerindeki ortalama hız bileşenleri 𝑢́ , 𝑣́  ise bu doğrultulardaki çalkantı hızlarıdır. 

 

 

Şekil 3.1 Ani hızın zamanla değişimi 10 

Spalart-Allmaras modeli aerodinamik akışlar için geliştirilmiştir. Bunun için güneş 

panelleri etrafındaki akış incelemeleri sırasında türbülans modeli olarak tek denklemli 

Spalart-Allmaras türbülans modeli kullanılmıştır. 

3.4.1 Spalart-Allmaras modeli 

Spalart-Allmaras modeli kinematik türbülans viskozitesi için modellenmiş taşıma 

denklemi çözen bir denklem modelidir. Bu türbülans modeli tek denklemden oluşmaktadır. 

Diğer türbülans modellere göre tek bir taşıma denklemli olduğu için hesaplama açısından en 

tasarruflu modelidir. Spalart-Allmaras modeli, duvarla sınırlandırmış akışlar içeren hava-

uzay uygulamaları için tasarlanmıştır. Spalart-Allmaras modelinin, olumsuz basınç 

gradyenlarına maruz kalan sınır tabakaları için iyi sonuçlar verdiği gösterilmiştir 13.  

Boussinesq yaklaşımının kullanıldığı türbülans modellerinde, türbülans (eddy) 

viskozitesinin nasıl hesaplanacağı önemlidir. Türbülans modelinin çözdüğü taşıma 

denklemi, kinematik viskozite tanımının modifiye edilmiş bir halidir. Spalart-Allmaras 

modelindeki taşıma değişkeni, viskoz etkilerin görüldüğü yakın duvar bölgesi haricinde 

türbülans kinematik viskozitesi ile özdeştir 7. 
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Spalart-Allmaras orijinal biçimi, sınır tabakanın viskoziteden etkilenen bölgesinin 

olduğu düşük Reynolds sayısı modelidir. Ancak ANSYS programındaki bu türbülans modeli 

ağ yapısı kararlılığı yeterli düzeyde iyi olmadığında, duvar fonksiyonları kullanılarak 

modelin kullanılması tamamlanmaktadır.  

3.4.1.1 Taşıma denklemi 

Spalart-Allmaras türbülans modelindeki taşıma değişkeni, 𝑣̃, viskozite ile etkilenmiş 

olan yakın duvar bölgesi dışında türbülans kinematik viskozitesine benzerdir. 𝑣̃ için taşıma 

denklemi 

 𝜕

𝜕𝑡
(𝜌𝑣̃) +

𝜕

𝜕𝑥𝑖

(𝜌𝑣̃𝑢𝑖) = G𝑣 

+
1

𝜎𝑣̃
[

𝜕

𝜕𝑥𝑗
{(𝜇 + 𝜌𝑣̃)

𝜕𝑣̃

𝜕𝑥𝑗
} + 𝐶𝑏2𝜌 (

𝜕𝑣̃

𝜕𝑥𝑗
)

2

] − 𝑌𝑣 + 𝑆𝑣̃ 

 

 

(3-8) 

olarak yazılır. Burada ki C𝑣, türbülanslı viskozitenin üretimidir, 𝑌𝑣 ise duvar engellemesi ve 

viskoz sönümlemesi nedeniyle duvarın yakınında bölgede meydana gelen türbülanslı 

viskozitenin yıkımıdır. 𝜎𝑣̃ ve 𝐶𝑏2 sabit sayılar, 𝑣 terimi ise moleküler kinematik viskozitedir. 

𝑆𝑣̃ kullanıcı tanımlı kaynak terimidir. Spalart-Allmaras modelinde türbülans kinetik enerjisi 

𝑘 hesaplanmadığı için, Reynolds gerilmelerini tahmin ederken Boussinesq hipotezinde 

verilen denklemin son terimi dikkate alınmamıştır [14]. 

3.4.1.2 Türbülans viskozitesi modellenmesi 

Türbülanslı viskozite, 𝜇𝑡 

 
𝜇𝑡 = 𝜌𝑣̃𝑓𝑣1

 (3-9) 

denkleminden hesaplanmaktadır. 

Denklemdeki viskoz sönümleme fonksiyonu, 𝑓𝑣1
 

 
𝑓𝑣1

=
𝑋3

𝑋3 + 𝐶3
𝑉1

 (3-10) 

formla verilmektedir. Buradaki X 

 
𝑋 ≈

𝑉̃

𝑉
 (3-11) 

olarak verilmektedir. 
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3.4.1.3 Türbülans üretimi modellenmesi 

 

Üretim terimi, G𝑣, aşağıdaki şekilde modellenmektedir. 

 
G𝑣 = 𝐶𝑏1

𝜌𝑆̃𝑣̃ (3-12) 

 
𝑆̃ = 𝑆 +

𝑣̃

𝜅2𝑑2
𝑓𝑣2

 (3-12a) 

 
𝑓𝑣2

= 1 −
𝑋

1 + 𝑋𝑓𝑣1

 (3-12b) 

Bu denklemlerdeki 𝐶𝑏1
 ve 𝜅 sabit sayılardır. 𝑑 duvardan olan uzaklık, 𝑆 yer 

değiştirme tensörünün skaler ölçümüdür. Varsayılan olarak ANSYS Fluent programında, 

Spalart-Allmaras tarafından önerilen orijinal modelde olduğu gibi, 𝑆 girdabın büyüklüğüne 

dayanır. 

 
𝑆 = √2Ω𝑖𝑗Ω𝑖𝑗 (3-13) 

Buradaki Ω𝑖𝑗 rotasyon tensörünün oranıdır ve  

 

Ω𝑖𝑗 =
1

2
(
𝜕𝑢𝑖

𝜕𝑥𝑗
−

𝜕𝑢𝑗

𝜕𝑥𝑖
) (3-14) 

ile tanımlanmaktadır. S'in açıklaması, akış modeli formüle edildiği zaman en çok ilgilenilen 

duvar üzeri ve çevresindeki akışta, duvar çevresindeki bölgelerde oluşan girdap için 

türbülansın bulunmasıdır. Ancak, türbülans üretiminde ortalama gerilme etkisi hesaba 

katılması ve bir modifikasyon yapılması önerilmektedir. Bu modifikasyon 𝑆'in tanımı içinde 

gerilme tensörü ve rotasyonun birleşimidir. 

 

𝑆 = |Ω𝑖𝑗| + 𝐶𝑝𝑟𝑜𝑑𝑚𝑖𝑛(0, |𝑆𝑖𝑗| − |Ω𝑖𝑗|) (3-15) 

𝐶𝑝𝑟𝑜𝑑 = 2.0 , |Ω𝑖𝑗| ≡ √2Ω𝑖𝑗Ω𝑖𝑗  , |𝑆𝑖𝑗| ≡ √2𝑆𝑖𝑗𝑆𝑖𝑗   olarak tanımlanmaktadır. 

Ortalama gerilme oranı ile 𝑆𝑖𝑗  

 

𝑆𝑖𝑗 =
1

2
(
𝜕𝑢𝑗

𝜕𝑥𝑖
−

𝜕𝑢𝑖

𝜕𝑥𝑗
) (3-16) 
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olarak tanımlanmaktadır. Dahil edilen rotasyonel ve gerilme tensörleri girdap viskozitesinin 

üretimini düşürür ve türbülanstaki dönme etkisi için doğru hesap yapmaktadır. Sadece 

rotasyonel tensörü ilave etmek girdap viskozitesi üretimini daha yüksek tahmin etmeye 

eğilimlidir. 

3.4.1.4 Türbülans yıkımı modellenmesi 

Yıkım terimi 𝑌𝑣 

 

𝑌𝑣 = C𝑤1ρ𝑓𝑤 (
𝑣̃

𝑑
)
2

 (3-17) 

olarak modellenmektedir. Bu bağıntıdaki 

 

𝑓𝑤 = 𝑔 [
1 + 𝐶𝑤3

6

𝑔6 + 𝐶𝑤3
6 ]

1
6⁄

 (3-17a) 

 

𝑔 = 𝑟 + 𝐶𝑤2(𝑟
6 − 𝑟) (3-17b) 

 
𝑟 =

𝑣̃

𝑆̃𝜅2𝑑2
 

 

(3-17c) 

şeklindedir. C𝑤1, C𝑤2ve C𝑤3 sabit sayılardır, 𝑆̃ ise (3-12a) denkleminde verilmişti. S 

üzerindeki ortalama gerilme etkilerini içermek için yukarıdaki açıklanan modifikasyon, aynı 

zamanda, r'yi hesaplamak için kullanılan 𝑆̃ değerini de etkileyeceğine dikkat edilmelidir. 

3.4.1.5 Model sabit sayıları 

Spalart-Allmaras modelindeki tanımlanan tüm sabitlerin varsayılan değerleri 

aşağıdaki gibidir [11]. 

𝐶𝑏1 = 0.1355 C𝑤1 =
𝐶𝑏1

𝜅2
+

1 + 𝐶𝑏2

𝜎𝑣̃ 
 

𝐶𝑣1 = 7.1 

𝐶𝑏2 = 0.622 C𝑤2 = 0.3 
𝜅 = 0.4187 

𝜎𝑣̃ =
2

3
 C𝑤3 = 2,0 
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4 DOĞRULAMA ÇALIŞMASI 

Bu bölümde, önceki bölümlerde sunulan sayısal modelleme ve analiz araçları 

literatürdeki mevcut verilerle doğrulanmıştır. Doğrulama çalışması için Veysel Emre USLU 

(USLU, V. E. 2014) tarafından yapılan sayısal analiz ve deneysel çalışmalar göz önünde 

bulundurulmuştur. Doğrulama çalışması için, Veysel Emre USLU 'nun sayısal analizi ve 

deneysel çalışması dikkate alınmıştır. 

4.1 Deneysel Çalışmalar  

USLU tarafından eğimli güneş panellerine etkiyen rüzgâr yüklerinin belirlenmesinde 

yapılan sayısal analiz çalışmasının bir bölümü olarak, analiz metodolojisinin doğruluğunu 

değerlendirmek için deneysel bir çalışma da yapılmıştır. Deneysel çalışma Orta Doğu 

Teknik Üniversitesi (ODTÜ) Rüzgâr Enerjisi Merkezi'nin Aerodinamik Laboratuvarı’nda 

gerçekleştirilmiştir. Daha sonra deneysel sonuçlar da sayısal analizle doğrulanmıştır. 

Orta Doğu Teknik Üniversitesinde deneyler, Aerodinamik Laboratuvarı’ndaki 

bulunan emme tipi düşük hızlı rüzgâr tünelinde yapılır. Rüzgâr tüneli, 2 m tamamen şeffaf 

test bölümüyle 1 × 1 m2 kesit alanına sahiptir. Tünel, hızı ayarlamak için hertz kontrol cihazı 

45 kW elektrik motoruna sahiptir. Bu elektrik motoru, 1,2 m çapında bir aksiyal vantilatör 

kullanır. Tünel tarafından elde edilebilecek maksimum hız 24 m / s'dir. 

Eğimli bir güneş panelini benzetmek amacıyla, yeterli dayanım, sertlik ve ağırlığa 

sahip olan sunta bir gövde oluşturulur. Gövde 2 cm x 20 cm x 96 cm boyutlarındadır ve 23N 

ağırlığındadır. Deneyde kullanılan gerinme ölçerler, 50 N’luk bir gövde ağırlığını taşımaya 

yetecek güce sahiptir. 

Sayısal analizleri doğrulamak için, 5 m/s ve 10 m/s rüzgâr hızında farklı açılar ile 

eğimli gövde üzerinde deneyler yapılmıştır. Ancak inceleme amacıyla; 0°, 15°, 25° ve 30°açı 

ile eğimli gövde sonuçları kullanılmıştır. Deneylerden elde edilen ve bahsedilmiş açılar ile 

eğimli gövdedeki sürükleme ve kaldırma kuvvetleri Çizelge 4.1'de sunulmuştur. 
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Çizelge 4.1  Deneysel çalışmalar sonuçları 

Rüzgâr hızı 5 m/s 10 m/s 

Eğim açısı 

(◦) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

35 2.61 -3.08 11.53 -12.97 

30 2.21 -2.88   9.61 -11.97 

25 1.77 -2.47   7.73 -10.90 

15 0.95 -1.87   4.44   -8.36 

0 0.29 -0.55   1.24   -2.53 

 

Yukarıdaki çizelgeye göre, gövdenin eğim açısı 0 olduğunda beklenen değerler 

sonuçlanmamıştır. Kaldırma kuvvetinin sıfıra yaklaşması beklenmiştir. Ancak kaldırma 

kuvvetinin sürükleme kuvvetinden daha büyük olduğu görülmüştür. Bunun nedeni, 

suntaların fiziksel geometrisi ya da muhtemelen yüzeyinde mevcut hafif düzensizlikler 

olabilir. Ayrıca, rüzgâr tüneli testlerinde bu aşırı eğim durumlarını kurmadaki ufak yanlış 

hizalamaların, bu durumlarda da artan hatalara neden olabileceği de mümkündür. 

4.2 Rüzgâr Tüneli Testinde kullanılan gövdenin HAD Analizi 

Rüzgâr tünelinde yapılan deneyin nümerik analizini gerçekleştirmek için, deney 

düzeneği ANSYS FLUENT'te modellenmiştir. Rüzgâr alanı, gövdenin öncesi ve sonrası 

akacak yeterli hava mesafesine sahip 1m x 1m rüzgâr tünelinin kesitini temsil etmek üzere 

yaratılmıştır. Sunta gövdesini temsil etmek için 96 cm x 20 cm x 2 cm boyutlarında bir model 

oluşturulur. Bu gövde her taraftan 2 cm uzağa yerleştirilmiş ve sayısal rüzgâr tünelinin 

kesitinin ortasına ortalanmıştır (Bkz. Şekil 4.1) [3]. 
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Şekil 4.1 Rüzgâr tüneli deneyinin mesh hali [3] 

Hız girişinde 5 m/s ve 10 m/s rüzgâr hızları için nümerik analiz yapılmıştır. Model 

SST k-𝜔 metodu ile çalıştırılmıştır. HAD analizlerinin sonuçları Çizelge 4.2'de sunulmuştur. 

Çizelge 4.2  USLU'ya göre HAD analizi sonuçları 

Rüzgâr hızı 5 m/s 10 m/s 

Eğim açısı 

(◦) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

35 2.84 -3.56 11.45 -14.33 

30 2.39 -3.41   9.61 13.72 

25 1.93 -3.16   7.74 -12.69 

15 1.14 -2.67   4.57 -10.61 

0 0.33 0   1.32 0 

4.3 Karşılaştırma 

Bu çalışmada kullanılan ve bölüm 3'te açıklanan yöntemi doğrulamak için deneyde 

USLU tarafından kullanılan aynı model tasarlanmıştır. 2 metrelik bir rüzgâr tüneli, 1m x 1m 

kesite sahip olacak şekilde tasarlanmıştır. 96 cm x 20 cm x 2 cm boyutlarında bir güneş 

panelinin modeli oluşturulmuştur (Bkz. Şekil 4.2). Model rüzgâr tünelinin ortasına 

yerleştirilmiştir. Model, deneyde kullanılan aynı açılarla da yatırılmıştır. 
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Şekil 4.2 Bu çalışmaya göre rüzgâr tüneli 

Sonlu elemanlara bölme işleminde gövdenin küçük kalınlıklarından dolayı kenar 

boyutlandırma teknikleri kullanılmıştır. Prizma şeklindeki rüzgâr tüneli modelinin kenarları, 

her kenar başına bölünmeler sayısıyla 200'e bölünmüştür. Gövdenin kenarları elemanın 

büyüklüğüne göre 20 ve 30 mm'ye bölünmüştür. Tüm model parçaları katı elemanlar olarak 

modellenmiştir. Modelin son mesh halleri Şekil 4.3'te bulunur. 

 

Şekil 4.3  Bu çalışmaya göre son mesh hali 

Sınır şartlarının ve analiz yöntemi belirlenmesi için Bölüm 3'te açıklandığı gibi aynı 

veriler girilmiştir. Çözümleme için iterasyon sayısı 1500 olarak belirlenmiştir. Analiz 

tamamlandıktan sonra, Çizelge 4.3'te sunulan sonuçlar elde edilmiştir. 
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Çizelge 4.3  Bu çalışmaya göre HAD analizi sonuçları 

Rüzgâr hızı 5 m/s 10 m/s 

Eğim açısı 

(◦) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

Sürükleme 

kuvveti 

(N) 

Kaldırma 

kuvveti 

(N) 

35 2.61 -3.70 10.39 -14.78 

30 2.03 -3.49   8.03 -13.84 

25 1.53 -3.26   6.12 -13.02 

15 0.76 -2.77   2.98 -10.91 

0 0.03 -0.03   0.11   -0.13 

 

Bu çalışmada elde edilen analitik sonuçlar ile USLU tarafından elde edilen sonuçlar 

arasındaki karşılaştırdığında, sonuçların bir dereceye kadar yakın olduğunu fark edilmiştir. 

Deneysel sonuçlarla karşılaştırıldığında, bu çalışmada elde edilen kaldırma 

kuvvetlerinin deneyde elde edilen değerlerden daha büyük olduğu görülmüştür. Fakat 

sürükleme kuvvetlerinin deneyde elde edilen değerlerden daha küçük olduğu görülmüştür. 

Ancak USLU tarafından elde edilen sonuçlar, hep deneysel sonuçlardan daha büyüktür. 

Kaldırma, akış yönüne dik toplam aerodinamik kuvvetin bileşeni olarak tanımlanır 

ve sürükleme akış yönüne paralel olan bileşendir [26]. Böylece iki kuvvetin toplamını 

bularak toplam aerodinamik kuvvetleri elde edilir. Şekil 4.4'e göre, Pisagor teoremi 

(toplam aerodinamik kuvveti = √(Sürükleme kuvveti )2 + (Kaldırma kuvveti )2) 

toplam aerodinamik kuvvetleri elde etmek için kullanılabilir. Toplam aerodinamik kuvveti 

hesaplanarak, Çizelge 4.4'teki değerler elde edilmiştir. 

 

Şekil 4.4 Aerodinamik kuvvetler [26] 
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Çizelge 4.4  Deney ve analizlere göre toplam aerodinamik kuvvetler 

Rüzgâr 

hızı 

Eğim 

açısı 

(◦) 

Deney ’in 

toplam 

aerodinamik 

kuvvetleri 

(N) 

Bu 

çalışmanın 

toplam 

aerodinamik 

kuvvetleri 

(N) 

USLU’nun 

toplam 

aerodinamik 

kuvvetleri 

(N) 

Bu 

çalışmadaki 

% hata 

USLU’nun 

çalışmasında 

% hata 

5 m/s 

35   4.04   4.53   4.56  12.13  12.83 

30   3.63   4.03   4.16  11.04  14.60 

25   3.07   3.60   3.71  18.43  21.99 

15   2.10   2.87   2.90  36.58  38.11 

0   0.62   0.04   0.33 -93.01 -47.02 

10 m/s 

35 17.35 18.07 18.34    4.16    5.69 

30 15.35 16.00 16.75    4.24    9.14 

25 13.37 14.38 14.86    7.61  11.16 

15   9.47 11.32 11.55  19.51  21.98 

0   2.82   0.17   1.32 -94.12 -53.01 

 

Burada, kaldırma kuvvetlerinin negatif işaretinin panellerin kaldırmaya değil basınca 

maruz kalacağı anlamına gelmektedir. Buna göre, toplam aerodinamik kuvvetleri basınçtır 

(üst yüze basınç ve alt yüze emme). 

Toplam aerodinamik kuvvetler ışığında, bu çalışmada kullanılan akış koşullarına 

göre elde edilen sonuçların deneysel sonuçlara USLU tarafından elde edilen sonuçlardan 

daha yakın olduğu fark edilmiştir. Ancak, iki çalışmanın analitik sonuçları göz önüne 

alındığında, deneysel sonuçlar ile %20 'ye kadar bir fark ortaya çıkmıştır. Ayrıca bu oran, 

gövdenin eğim açısı sıfırken %20'den fazladır. Gövdenin eğim açısı 0 olduğunda, kaldırma 

kuvvetinin sıfıra yaklaşması gerekiyordur. Ancak deneysel sonuçlar biraz farklı çıkmıştır. 

Bu durum, deneyin hatalarına bağlanabilir. Dolayısıyla bu durumdaki sıfıra daha yakın olan 

analitik sonuçlar daha doğru çıkmıştır. 

Sonuçlarda gözlenen  farklılıklar ışığında, bunların nedenlerini de tartışmak 

önemlidir. Öncelikle, deneysel kurulumun sayısal ortamda tam olarak modellenmemiş 

olabileceğini belirtmek gerekir. İnsan hatası ve ölçüm hataları, özellikle rüzgâr tünelinde 

yapılan testlerde her zaman mevcuttur. Ayrıca, çevresel koşullar ve öngörülemeyen faktörler 
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sayısal modelde dikkate alınmaz. Sayısal analizde, koşullar idealin yanındadır. Deneydeki 

gövdenin, malzeme kusurundan ve bağlantı çubuklarının yerleştirmesinden dolayı 

yanlarında ek bir sürtünme yoktur. Ayrıca, suntaların uç bağlantı çubukları ile rüzgâr 

tünelinin gerinme ölçerleri de sonuçlarda ufak bir değişiklikle sonuçlanmış olabilir. 

Bu potansiyel kararsızlıklar ışığında, deney ve sayısal analizlerin bulunan sonuçları 

yeterince kabul edilebilir. Bu analizlerle, bölüm 3'te verilen Spallart-Allmaras modelinin ve 

analizinin, rüzgâr tünelinde yapılan deneylere kıyasla gövdelere etki eden rüzgâr yüklerinin 

hesaplanmasında güvenilir bir yöntem sağladığı görülmüştür. 
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5 HESAPLAMALI AKIŞKANLAR DİNAMİĞİNİN (HAD) İŞLEMİNİN 

ADIMLARI 

Bu bölümde, hesaplamalı akışkan dinamiği (HAD) analizi, HAD modellemesi ve 

pratik arka plan hakkında genel bilgiler sunulmuştur. Güneş panellerinin rüzgâr tüneli 

testlerini kullanarak deneysel araştırma çalışmaları yapmak, çoğunlukla araştırma 

laboratuvarlarının fiziksel kısıtlamaları nedeniyle çok zor bir iştir. Rüzgâr etkisini 

değerlendirmek için, rüzgâr tünellerine güneş sistemleri yerleştirilmelidir. Ölçekli 

maketlerin kullanılması her zaman mümkün olsa da ölçekli maketlerin kullanılması bile 

normal rüzgâr tünellerinde güvenilir rüzgâr tüneli testlerinin yapılmasına izin vermeyebilir. 

Bu nedenle, böyle bir testi yapmanın fiziksel gerekliliklerini telafi edecek kadar büyük bir 

rüzgâr tüneli test tesisine sahip olmak önemlidir. Bu bakımdan, böyle büyük test tesisleri 

sadece çok az sayıda laboratuvarda bulunmaktadır 3. 

Rüzgâr tüneli testleri yapmak yerine, mühendislik problemlerinin çözümünü 

gerçekleştirmek için HAD analizi araçlarını kullanmak da popüler olmuştur. Bu tez 

çalışmasında ANSYS FLUENT, rüzgâr kuvvetlerinin güneş panelleri üzerindeki etkilerini 

modellemek için kullanılmıştır. Elimizdeki fiziksel problemin modellenmesi açısından, 

problemin 2 boyutlu (2D) ve 3 boyutlu (3D) modellenmesi mümkündür. Bu bölümde, 

öneriler temel olarak 3D HAD analizi için verilmiştir; ancak, 2D HAD analizi için de 

geçerlidirler. Bu nedenle, 2D HAD analiz önerileri burada gösterilmemiştir. Bu iki seçenek 

arasındaki tek fark, geometri ve ağ örgüsüdür. 

HAD terimi, üç boyutlu ve zamana bağlı karmaşık akış problemlerini çözmek için 

kullanılan geniş spektrumlu bir sayısal yöntemleri ifade etmek için kullanılır. Bu bilimsel 

alan, aslında Navier-Stokes denklemini sayısal olarak çözmek için ilkel yaklaşımlardan 

geliştirildi. Bu denklemin çözülmesi, bugüne kadar sayısal fizikte en zorlu problemlerden 

biridir. Bu çalışmada ANSYS Workbench 17.1 programı kullanılarak HAD analizi 

yapılmıştır. Model, ANSYS Tasarım Modelleyicisi kullanılarak HAD analizine uyacak 

şekilde değiştirilmiştir. 

Rüzgâr kuvvetinin etkisi paneller üzerinde en büyük olduğu için rüzgârın sadece 

paneller üzerindeki etkisini simüle edilmiştir. Simülasyon sayesinde paneller üzerindeki 

rüzgâr yükünün dağılımını bulunabilir, daha sonra tüm güneş sistemi analiz etmek için elde 

edilen rüzgâr yükünü basınç yükü olarak kullanılabilir. Bunun için HAD simülasyonunda 

paneller hariç tüm sistem elemanları kaldırılmıştır. 
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Analiz ilk önce düz arazi uygulamalı paneller için yapılmış ve bu kısımda analiz 

adımları tek tek anlatılmıştır. Daha sonra düz olmayan arazi (10, 20 ve 30 dereceyle eğik) 

uygulamalı paneller için, tekrar analiz yapılmıştır. Panellerin ardışık etkisini incelemek için 

panellerin birkaç kopyası (Beşe kadar) her model için arka arkaya yerleştirilmiştir. Ardışık 

kopyalar arasındaki yatay aralık 3 metredir. İşlem adımları aynı olduğu için adımlar bir kez 

anlatılmıştır. 

5.1 Rüzgâr Tüneli Mantığının Oluşturulması 

Ansys Workbench programı açılır ve Fluent modülü seçilir.  Geometry > Import 

Geometry > Browse adımları takip edilerek model yüklenir (Bkz. Şekil 5.1). 

 

 

Şekil 5.1 Analiz modülünün seçilmesi 

Solidworks programında çizilen model, Ansys programında okunabilmesi için STEP 

(*.step) olarak kaydedilmiştir. “Geometry” tuşuna çift tıklayarak DesignModeler programı 

ile çizilen model açılır (Bkz. Şekil 5.2). 
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Şekil 5.2 Temsili güneş enerji sisteminin modeli 

Rüzgâr etkisi paneller üzerinde baskın olduğu için rüzgârın sadece paneller 

üzerindeki etkisi simüle edilmiştir. Bunun için HAD simülasyonu esnasında paneller hariç 

tüm sistem elemanları Create > Delete Body adımları takip edilerek kaldırılmıştır (Bkz. Şekil 

5.3). 
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Şekil 5.3 Taşıyıcı sistemin kaldırılması 

5.1.1 Düz arazi uygulamalı 

Tools > Enclosure adımları takip edilir ve sol alt kısımda çıkan ekranda; 

Shape = Box, Cushion = Non-Uniform 

+X value = 10m, +Y value = 10m, +Z value = 10m 

- X value = 10m, - Y value = 0,6m, - Z value = 10m  

değerleri girilerek “Generate” tuşuna basılır ve paneller etrafında yeterince hava 

akımı sağlayacak kadar dikdörtgen prizması şeklinde rüzgâr tüneli modeli oluşturulur (Bkz. 

Şekil 5.4). 
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Şekil 5.4 Düz arazi uygulamalı için rüzgâr  tüneli 

5.1.1.1 Ardışık paneller 

Bu aşamada paneller üzerindeki ardışık etkisini incelemek için Create > Body 

Transformation > Translate adımları takip edilerek 3 metre yatay aralıkla aşağıdaki gibi beş 

model oluşturulmuştur: 

1. Tek sıra (ana model). 

2. Arka arkaya iki sıra (Bkz. Şekil 5.5).   

3. Arka arkaya üç sıra (Bkz. Şekil 5.6).  

4. Arka arkaya dört sıra (Bkz. Şekil 5.7).  

5. Arka arkaya beş sıra (Bkz. Şekil 5.8). 
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Şekil 5.5 Düz arazi uygulamalı iki sıra için rüzgâr  tüneli 

 

Şekil 5.6 Düz arazi uygulamalı üç sıra için rüzgâr  tüneli 
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Şekil 5.7 Düz arazi uygulamalı dört sıra için rüzgâr  tüneli 

 

Şekil 5.8 Düz arazi uygulamalı beş sıra için rüzgâr tüneli 
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Create > Boolean adımları takip edilir ve sol alt kısımda çıkan ekranda; 

Operation = Subtract 

Target Bodies = Rüzgâr tüneli modeli 

Tool Bodies = Panellerin modeli seçilerek “Generate” tuşuna basılır. 

Böylece, rüzgâr tüneli modelinden paneller modelinin alanı çıkarılmış olur. Hava 

akışı geri kalan alan üzerinden olacaktır ve boş kalan alan paneller modelinin alanı olduğu 

için, o hacim içinden herhangi bir akış gerçekleşmeyerek rüzgâr tüneli mantığı oluşturulmuş 

olacaktır. 

5.1.2 Düz olmayan arazi uygulamalı 

Burada, önceki dikdörtgen prizması şeklindeki rüzgâr tüneli modelinin alttaki 

düzeyinin bir kısmı 10° , 20° ve 30° açı ile eğilmiştir. Bunu yapmak için, boyutları yeterince 

büyük olan bir beşgen çizilmiştir. Sonra Create > Extrude adımları takip edilir ve sol alt 

kısımda çıkan ekranda; 

Geometry = Çizilen beşgen, Direction = Both-Asymmetric, Extent Type = Fixed 

Depth = 25m, Depth 2= 35m değerleri girilerek “Generate” tuşuna basılır ve paneller 

etrafında yeterince hava akımı sağlayacak kadar beşgen prizması şeklinde rüzgâr tüneli 

modeli oluşturulur (Bkz. Şekil 5.9, 5.10 ve 5.11). 

 

 

Şekil 5.9 10° ile eğimli arazi uygulamalı için rüzgâr  tüneli 
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Şekil 5.10 20° ile eğimli arazi uygulamalı için rüzgâr  tüneli 

 

Şekil 5.11 30° ile eğimli arazi uygulamalı için rüzgâr  tüneli 
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5.1.2.1 Ardışık paneller 

Bu aşamada da paneller üzerindeki ardışıklık etkisini incelemek için güneş paneli 

sistemi yatay olarak 3 metre ve dikey olarak eğik araziye oturuncaya kadar aralıklar ile 

taşınmıştır. Create > Body Transformation > Translate adımları takip edilerek aşağıdaki gibi 

on beş model oluşturulmuştur: 

1. 10° eğimli arazi (Bkz. Şekil 5.12).   

▪ Tek sıra (ana model). 

▪ Arka arkaya iki sıra. 

▪ Arka arkaya üç sıra.  

▪ Arka arkaya dört sıra.  

▪ Arka arkaya beş sıra. 

 
 

Şekil 5.12 10° ile eğimli arazi uygulamalı ardışık paneller 

2. 20° eğimli arazi (Bkz. Şekil 5.13).   

▪ Tek sıra (ana model). 

▪ Arka arkaya iki sıra.   

▪ Arka arkaya üç sıra.  

▪ Arka arkaya dört sıra.  

▪ Arka arkaya beş sıra. 
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Şekil 5.13 20° ile eğimli arazi uygulamalı ardışık paneller 

3. 30° eğimli arazi (Bkz. Şekil 5.14).    

▪ Tek sıra (ana model). 

▪ Arka arkaya iki sıra.   

▪ Arka arkaya üç sıra.  

▪ Arka arkaya dört sıra.  

▪ Arka arkaya beş sıra. 
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Şekil 5.14 30° ile eğimli arazi uygulamalı ardışık paneller 

5.2 Sonlu Elemanlara Bölme İşlemi 

Akış gerçekleşecek bölgenin sonlu elamanlara ayrılması olayıdır. Bu elemanlar tek 

tek çözülerek ve aralarındaki korelasyon kullanılarak problemin tamamı çözülmektedir. 

Sonlu elemanlar metodu aslında problemin kesin çözümünün değil, çözüme olabildiğince 

yaklaşan sonuçların incelemesidir. Mesh için seçilen elemanlar modele ne kadar uygun ve 

küçük seçilebilirse çözüme o kadar yaklaşılır. Ancak meshin sıklığı bilgisayar performansını 

doğrudan etkilemektedir ve kullanıcıyı kısıtlamaktadır 15. 

Güneş panellerinin küçük kalınlıklarından dolayı kenar boyutlandırma teknikleri 

kullanılmıştır. Prizma şeklindeki rüzgâr tüneli modelinin kenarları, her kenar başına 

bölünmeler sayısıyla 200'e bölünmüştür. Güneş panellerinin kenarları elemanın 

büyüklüğüne göre 50 mm'ye bölünmüştür. Çünkü asıl önemli olan bu güneş panellerinin 

üzerinde oluşacak basınçtır. Tüm model parçaları katı elemanlar olarak modellenmiştir. 
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Ansys Workbench ana ekranında Mesh > Edit adımları takip edilir. Rüzgâr tünelinin 

kenarları için açılan CFD-mesh ekranında Mesh > Insert > Sizing adımları takip edilir ve sol 

alt kısımda çıkan ekranda; 

Geometry: Prizma kenarları, 

Type: Number of Divisions, 

Number of Divisions: 200, 

rüzgâr tüneli modelini meshlenir (Bkz. Şekil 5.15 ve 5.16). 

 

 

Şekil 5.15 Düz olan rüzgâr tüneli kenarlarının mesh detayları 

 

Şekil 5.16 Düz olmayan rüzgâr tüneli kenarlarının mesh detayları 
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Panellerin kenarları için açılan CFD-mesh ekranında Mesh > Insert > Sizing adımları 

takip edilir ve sol alt kısımda çıkan ekranda; 

Geometry: Panellerin kenarları, 

Type: Element Size, 

Element Size: 50 mm, 

panellerin modelini meshlenir (Bkz. Şekil 5.17). 

 

 

Şekil 5.17 Güneş panelleri kenarlarının mesh detayları 

Bilgisayar grafiklerinde birçok nesne resmedilmeden önce mesh yapısına 

dönüştürülür. Fakat ana kullanım alanı sonlu elemanlar yöntemi içinde kullanılmasıdır. 

Yüzeysel tanım aralıkları üçgen, dörtgen vb. şekillere bölünebilirken, hacimsel tanım 

aralıkları tetrahedral ( dört yüzlü), hexahedral (altı yüzlü) gibi şekillere bölünebilir. 

Elemanların şekli ve dağılımı otomatik mesh üretme algoritmaları tarafından belirlenir 20. 

Modellerin mesh halleri Şekil 5.18 ve 5.19'de bulunur. 
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Şekil 5.18 Düz arazi uygulamalı modelin meshlenmiş hali 

 

Şekil 5.19 Düz olmayan arazi uygulamalı modelin meshlenmiş hali 
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Daha sonra modelin sınır şartlarının belirleneceği kısımlar; Rüzgâr tünelinin hava 

giriş kısmı IN, çıkış kısmı OUT, yan duvarlar için ARROUNDING ve paneller kısmı için 

CELLS olarak adlandırılır. 

Giriş seçilir > Create Named Selection > IN  (Bkz. Şekil 5.20), 

Çıkış seçilir > Create Named Selection > OUT (Bkz. Şekil 5.21), 

Yan duvarlar seçilir > Create Named Selection > ARROUNDING (Bkz. Şekil 5.22), 

Paneller seçilir > Create Named Selection > CELLS (Bkz. Şekil 5.23), 

“Update” tuşuna basılır. 

 

 

Şekil 5.20 Düz ve düz olmayan rüzgâr  tüneli girişi 
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Şekil 5.21 Düz ve düz olmayan rüzgâr  tüneli çıkışı 

 

Şekil 5.22 Düz ve düz olmayan rüzgâr  tüneli yan duvarları 
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Şekil 5.23 Düz ve düz olmayan rüzgâr  tüneli güneş panelleri 

5.3 Sınır Şartlarının Belirlenmesi 

Ansys Workbench ana ekranında Setup > Edit adımları takip edilir ve açılan 

pencerede “Double Precision” seçeneği işaretlenir (Bkz. Şekil 5.24). Çift hassasiyetli 

çözücüde her kayan nokta sayısında tek hassasiyetli çözücüde 32-bit kullanımının aksine 64-

bit kullanarak ekstra hassasiyet sağlamaktadır. Fakat bellek kullanımını arttırmaktadır 15. 

 

 

Şekil 5.24 Çözümleme yönteminin seçilmesi 
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5.3.1 Türbülans modelinin belirlenmesi 

Models > Viscous-Laminer > Edit > Spalart–Allmaras (1 eqn) adımları takip edilir. 

Açılan pencerede “Spalart–Allmaras Production” kısmındaki “Vorticity-Based” seçeneği 

işaretlenerek “OK” tuşuna basılır (Bkz. Şekil 5.25). 

 

 

Şekil 5.25 Türbülans modelinin seçilmesi 

5.3.2 Akışkan ve özelliklerinin belirlenmesi 

Akışkan olarak 15°C’de hava kullanılmıştır. Material > Fluid > air adımları takip 

ederek havanın bu sıcaklıktaki özellikleri aşağıdaki gibi Fluent modülü içinde bu değerler 

tanımlanmıştır (Bkz. Şekil 5.26).  

Yoğunluk = 1.225 kg/m3 

Vizkozite = 1.7894×10-5  kg.m−1. s−1 dir. 
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Şekil 5.26 Akışkanın tanımlanması 

5.3.3 Sınır koşullarının girilmesi 

Rüzgâr tüneli, akıcının (rüzgâr) akacağı bölgeyi sağlayacaktır. Akıcı akışı ve güneş 

panelleri arasındaki sınırların yanı sıra tünel sınırları HAD analiz aracına dikkatlice 

verilmelidir. 

Rüzgâr tüneli girişinde sadece hız, çıkışında sadece basınç değerleri programa 

girilmiştir. Hareket denklemlerinde hız ve basınç bağlı olduğundan, hız girişinde basınç 

belirtilemez. Çünkü bu durum aşırı matematiksel tanımlamaya yol açar. Üstelik bir hız 

girişindeki basınç, akış alanının geri kalanına uymak için kendisini ayarlar. Benzer şekilde, 

bir basınç girişinde veya çıkışında hız belirtilmez, çünkü bu da matematiksel olarak aşırı 

tanımlamaya yol açar. Basıncın belirtildiği bir sınır şartında hız, akış alanının geri kalanına 

uymak için kendisini ayarlar 715. 

Bir basınç çıkışında (pressure outlet), akışkan hesaplama bölgesinden dışarı 

akmaktadır. Statik basıncı çıkış yüzü boyunca belirtilmiştir. Genelde bu basınç atmosferik 

basınçtır (sıfır etkin basıncı). 

Giriş = Akışkanın girdiği yüzeydir. 

Cisim (model) etrafındaki akış, tamamıyla görecelidir ve cismin, durgun akışkan 

içerisinde hareketli olması ile sonsuzda üniforma hıza sahip bir akışkan içerisinde sabit 

durması arasında bir fark yoktur. Bu yüzden rüzgâr tünelinde giriş hızı akışkana verilmiştir.  

Güneş paneli sisteminin yüksekliği 0-8 m arasında olduğu için TS498'e göre rüzgâr 

hızı 28 m/s olmalıdır. 
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Boundary Conditions > inlet > Edit adımları takip edilir. Giriş kısmının 

adılandırılması “in” olarak yapıldığı için Type kısmındaki “velocity inlet” tanımlanmalıdır. 

Açılan pencerede Velocity Specification Method “Magnitude, Normal to Boundary” 

(Büyüklük, Sınıra Normal) olarak seçilir. Hız 28 m/s değeri girilir (Bkz. Şekil 5.27). 

 

 

Şekil 5.27 Giriş koşulunun girilmesi 

Çıkış = Akışkanın çıktığı yüzeydir. 

Boundary Conditions > outlet > Edit adımları takip ederek açılan pencerede Gauge 

Pressure (pascal) kısmına 0 değeri girilir. Çıkış kısmının adılandırılması “out” olarak 

yapıldığı için Type kısmındaki “pressure-outlet” olarak tanımlanmalıdır (Bkz. Şekil 5.28). 

 

 

Şekil 5.28 Çıkış koşulunun girilmesi 

Wall = Akışkanın akışına karşı katı sızdırmaz elemanlardır. Akışkanın 

geçemeyeceği sınır olarak da isimlendirilebilir. “ARROUNDING” ve “CELLS” olarak 
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isimlendirilen kısımlar Type kısmında otomatik olarak wall olarak tanımlanmıştır. 

Akışkanın duvar yüzeyinde hızı ve kayma gerilmeleri sıfırdır. 

Referance Values > Compute from (in) adımları takip ederek, daha önce yapılan 

işlemler doğrultusunda program tarafından tanımlanmış değerler görünür (Bkz. Şekil 5.29). 

 

 

Şekil 5.29 Giriş kısmı için tanımlanmış değerler 

5.4 Analiz Yöntemi 

Şekil 5.30 çözümlemede kullanılan yöntemi göstermektedir. Aslında bu değerler 

program tarafından otomatik tanımlanır. Modifiye türbülanslı viskozite "First order upwind" 

olarak tanımlanmışsa o zaman ilkel çözümlemede kullanılabilir. Bunun için final çözümün 

doğruluğunu arttırmak için ikinci mertebeden ayrıklaştırma türü kullanılmıştır. 
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Şekil 5.30 Çözümlemede kullanılan yöntemi 

Solution Initialization > Hybrid Initialization adımları takip edilerek “Initialize” 

tuşuna basılarak hesaplama için son adım tanımlanır (Bkz. Şekil 5.31). Hibrit başlatma 

düzenler ve sınır enterpolasyon yöntemleri koleksiyonudur. Hız ve basınç alanlarını 

belirlemek için Laplace denklemi çözülür. Sıcaklık, türbülans, tür fraksiyonları, hacim 

fraksiyonları vb. gibi diğer tüm değişkenler, alan ortalama değerlerine veya belirli bir 

enterpolasyon düzenine dayanarak otomatik olarak yamalanacaktır. 

 

 

Şekil 5.31 Çözüm başlangıç durumuna getirmesi 
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Çözümleme için iterasyon sayısı 2500 olarak belirlenmiştir. “Initialize” tuşuna 

basılarak, girilmiş verilerde herhangi bir tutarsızlık veya hata varsa program ipuçları 

sunmaktadır. Run Calculation > Number of Iterations (2500) adımları takip ederek 

“Calculate” tuşuna basılmıştır (Bkz. Şekil 5.32). 

 

 

Şekil 5.32 İterasyön sayısı girilmesi ve heaplama çalıştırılması 
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6 DOĞRUSAL STATİK ANALİZİ İŞLEM ADIMLARI 

Doğrusal statik analizi adımlarına başlamadan önce, doğrusal olmayan bir analizin 

yapıldığı not edilmelidir. Taşıyıcı sistemindeki tüm elemanların elastik bölgesinde kalması 

nedeniyle doğrusal statik analizinin yeterli olduğu bulunmuştur. Doğrusal olmayan statik 

analizinin raporu eklerde bulunur. 

Statik analiz kısaca analiz edilecek yapıların ya da sistemlerin üzerlerine gelen 

durağan yüklerin ve kısıtlamaların anlık olarak analiz edilmesidir. Statik analiz zamana bağlı 

değildir. Yapılan statik analiz sonucuyla; 

▪ Sistemin ya da parçanın ne kadar yüklemeye karşı koyabileceği, 

▪ Konstrüksiyonun ne kadar güvenli olduğu (Emniyet Katsayısı Belirleme), 

▪ Yapının ne kadar sehim yaptığı, 

▪ Yapı üzerindeki minimum, maksimum ve eşdeğer gerilme değerlerinin hangi 

mertebelerde olduğu bulunabilir 16. 

Güneş panelleri yüzeylerindeki basınç dağılımı HAD simülasyonu sayesinde elde 

ettikten sonra tüm güneş sistemi için doğrusal statik analizi yapılmıştır. Statik analizi 

sayesinde toplam yer değiştirme, gerilme, gerinme ve reaksiyonlar elde edilebilir. Ayrıca, 

bu güneş sistemi için tasarlanan taşıyıcı modelin belirli rüzgâr yüküne dayanıp 

dayanmayacağını da belirleyebilir.  

Bu çalışmada kullanılan güneş enerji sistemi örneği, Şanlıurfa ili Siverek ilçesinde 

uygulanan 999 kW kapasiteli enerji üretim santralinden alınmıştır. Sistem, Şekil 6.1'de 

gösterildiği gibi bir taşıyıcı çelik yapıya monte edilen çift dizili 22 adet panellerden 

oluşmaktadır. Güneş panelleri 30 eğimli ve 4 tane çift U kesitli aşık profillerine monte 

edilmektedir. Aşıklar da 5 tane U kesitli kiriş profillerine ile her kiriş bir U kesitli kolon 

profiline ve iki L kesitli diyagonal profillerine monte edilmektedir. Kolonlar L kesitli çapraz 

profilleri ile birbirine bağlanmaktadır. Tüm profillerin detayları Çizelge 6.1'de gösterilmiştir. 

Her panelin boyutları 992 mm x 1650 mm'dir ve her iki panellerin arasındaki boşluk her iki 

yönde de 20 mm'dir. Kolonlar 1,5 metre derinliğinde bir beton temele sahiptir, ancak 

modellemede kolonları tespit etmek için zemin seviyesinde bir ankastre mesnet 

kullanılmıştır. 
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Şekil 6.1 Analizde kullanılan güneş panelleri ve taşıyıcı yapı 

 

Panellerin her iki tarafında oluşan toplam basınç farkı ve daha önce test edilen yük 

durumlarına göre, maksimum yükleme durumunun çoğu güneş panellerinin tek durması 

halinde olduğu gözlemlenmiştir. Bu nedenle, ardışıklık önemi ihmal edilerek tek duran 

güneş sistemi analiz edilmiştir. 

Analiz ilk önce düz arazi uygulamalı güneş enerji sistemi için yapılmış ve bu kısımda 

analiz adımları tek tek anlatılmıştır. Daha sonra düz olmayan arazi (10, 20 ve 30 dereceyle 

eğik) uygulamalı güneş enerji sistemi için, tekrar analiz yapılmıştır. İşlem adımları aynı 

olduğu için adımlar bir kez anlatılmıştır. 

İşlem adımlarında, önce Ansys Workbench programı açılır ve Static Structural 

modülü seçilir.  Geometry > Import Geometry > Browse adımları takip edilerek daha önce 

anlatıldığı gibi model yüklenir (Bkz. Şekil 6.2). Daha önce yapılan HAD analizi 

sonuçlarından Excel dosya olarak elde edilmiş basınç kuvvetini statik analizinde 

kullanabilmek için External Data modülü seçilir ve basınç Excel dosyası eklenir. Burada, 

eklenen dosya ile program arasındaki verilerin ve birimlerin uyumluluğuna dikkat edilmeli 

(Bkz. Şekil 6.3). Sonra External Data modülündeki Setup, Static Structural modülündeki 

Setup ile bağlanılır. 
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Çizelge 6.1  Profiller detayları 

 

Profil 
Kesit kalınlığı (mm) 

ve adedi 
Boyutları (mm) Şekli 

Aşık 2.5- 2 45×80×15 

 

Kiriş 2.5- 1 50×100×18 

 

Kolon 4- 1 50×140×20 

 

Çapraz 4- 1 40×40 

 

Diyagonal 4- 1 50×50 
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Şekil 6.2 Analiz modülünün seçilmesi 

 

Şekil 6.3 Basınç dosyası eklenmesi ile birimlerin ve verilerin uyumluluğu 
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6.1 Malzemelerin Tanımı 

Analizde kullanılan malzemeler, güneş panelleri için alüminyum ve taşıyıcı yapı için 

çeliktir. Güneş panelleri oluşturan tüm katmanların, aynı kalınlığa sahip bir alüminyum 

katmanına eşdeğer olduğu kabul edilmiştir. Malzemeleri eklemek için Engineering Data 

bölümüne çift tıklayıp Engineering Data Sources > General Materials adımları takip edilerek 

Aluminum Alloy ve Structural Steel ikonları işaretlenir (Bkz. Şekil 6.4).  

Analize eklendiği malzemelerin özelliklerini değiştirmek istenirse alt kısımdaki 

properties of outline row bölümünden değiştirebilir. Çizelge 6.2 kullanılan malzemelerin 

özelliklerini gösterilmiştir. 

ANSYS, birçok farklı materyal özellik verisini destekler. Bu veri tipleri, belirli bir 

analiz için tüm ilgili verileri sağlamak amacıyla, tek bir malzeme adı altında fonksiyonel 

gruplarda toplanmıştır 17. 

 

 

Şekil 6.4 Malzemelerin eklenmesi 
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Çizelge 6.2  Malzemelerin özellikleri 

Malzeme Yoğunluk 

(Kg/m3) 

Kesme 

modülü 

(Pa) 

Young 

Modülü 

(Pa) 

Poisson 

Oranı 

Akma 

dayanımı 

(Pa) 

Kopma 

dayanımı 

(Pa) 

Çelik 7850 7.6923E+10  2E+11 0.3 2.5E+08 4.6E+08 

Alüminyum 2770 2.6692E+10 7.1E+10   0.33 2.8E+08 3.1E+08 

 

Program tüm elemanları çelik olarak tanır çünkü bu materyal program tarafından 

otomatik eklenir. Bunun için çelik elemanlarını tanımlanmaya gerek yoktur. Alüminyum 

elemanları tanımlanmak için Model > Geometry adımları takip edilir.  Sonra Geometry 

listesindeki bulunan güneş panelleri seçilir ve sol alt kısımda çıkan ekranda; 

Assignment: Aluminum Alloy 

Seçerek alüminyum malzemesi tanımlanmıştır (Bkz. Şekil 6.5). 

 

 

Şekil 6.5 Alüminyum elemanları tanımlanması 
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6.2 Bağlantılar 

Statik analizde göz önünde bulundurulması gereken en önemli hususlardan biri 

geometrik elemanların birbirine bağlanmasıdır. Güneş panelleri, aşık profillerine klamplar 

tarafından tespit edilmiştir. Profiller cıvatalarla birbirine bağlanmıştır. ANSYS programı 

sayesinde, klamplar ve cıvatalar yerine bağlantı işlemini kullanabilir. Modeldeki farklı 

parçaları bağlamak için tüm eşleşen yüzeyler arasında yapışık bağlantılar kullanılmıştır.  

Yapışık bağlantı, bağlanan yüzeyler veya kenarlar arasında ayrıksız ve sonsuz 

sürtünmeli bir kontaktır. Bu temas türü doğrusal bir çözüme izin verir, çünkü temas uzunluğu 

/ alanı yükün uygulanması sırasında değişmez 18. Ansys programında, her bir temas 

bölgesi için temas ve hedef yüzeyleri kavramı kullanılmaktadır 19: 

▪ Bir temas bölgesinin bir tarafı bir temas yüzeyi olarak adlandırılır, diğer tarafı bir 

hedef yüzeyi olarak adlandırılır. 

▪ Temas yüzeyleri hedef yüzeye nüfuz etmeleri sınırlandırılmıştır. 

▪ Eğer her iki taraf temas ve hedef olmak için yapılmışsa buna simetrik temas denir. 

Varsayılan olarak, katı montajlar için simetrik temas kullanılır.  

 

 

Şekil 6.6 Yapışkan yüzeyler bağlaması 
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Yapışkan yüzeyler bağlamak için Model bölümüne çift tıklayıp Connections listesini sağ 

tıklayarak Insert > Manual Contact Region adımları takip edilir. Sol alt kısımda çıkan 

ekranda; 

Contact: temas yüzeyi  

Target: hedef yüzeyi 

Type: Bonded 

Seçerek temas bölgesinin her iki tarafı bağlanılmıştır (Bkz. Şekil 6.6). Böylece her yapışkan 

yüzeyler için aynı adımları tekrarlayarak bütün yapışkan yüzeyler bağlanmıştır. Elemanlar 

arasındaki bazı bağlantı biçimleri Şekiller 6.7, 6.8, 6.9 ve 6.10'da gösterilmiştir. 

 

 

Şekil 6.7 Güneş panellein aşıklar ile bağlanması 

 

Şekil 6.8 Aşıkların girişler ile bağlanması 
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Şekil 6.9 Girişlerin kolonlar ile bağlanması 

 

Şekil 6.10 Kolonların çarpaz profiller ile bağlanması 

6.3 Sonlu Elemanlar Bölme İşlemi 

Mesh üretme fiziksel bir tanım aralığını daha küçük tanım aralıklarına (elemanlara) 

bölme işlemi olarak tanımlanabilir. Burada amaç bir diferansiyel denklemin çözümünü 

kolaylaştırmaktır 20. Mesh üretmek için Model bölümüne çift tıklayıp Mesh listesini sağ 

tıklayarak Insert > Method adımları takip edilir. Sol alt kısımda çıkan ekranda; 

Geometry: Tüm modelin elemanları 

Method: Automatic 

seçerek Tetrahedron ve Sweep yöntemi kombinasyonu kullanılmıştır (Bkz. Şekil 6.11).  
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Otomatik Yöntem, taranabilir hacimleri otomatik olarak tanımlar ve tarama ağı 

oluşturur. Taranamayan tüm hacimler, Tetrahedron Patch Conformal yöntemi kullanılarak 

meshlenir 21. 

 

 

Şekil 6.11 Meh yöntemi seçilmesi 

Sonlu elemanlara bölmedeki kullanılan yöntemi seçtikten sonra modelin tüm 

elemanlarını seçerek Mesh listesini sağ tıklayıp Insert > Sizing adımları takip edilir. Sol alt 

kısımda çıkan ekranda (Bkz. Şekil 6.12); 

Geometry: Tüm modelin elemanları 

Type: Element Size 

Element Size: 30 mm 

Behavior: Soft 

seçilir ve "Update" tuşuna basılır. Böylece model 30 mm boyutunda sonlu elemanlara 

ayrılmıştır (Bkz. Şekil 6.13). 

Fakat burada önemli olan, güneş panellerine uygulanacak basınç yükünün harici bir 

dosyadan alınmasıdır. Bu dosya HAD simülasyonu sonuçlarından çıkarılmıştır. Dosyadaki 

rüzgâr yükünden gelen basınç, güneş panelleri koordinatlarına göre panellerin yüzeylerine 

dağıtılmıştır. Bu nedenle, basınç yükünün uygulandığı güneş panellerinin sonlu elemanlar 

yapısının daha sık olması çok önemlidir. Aksi takdirde, dosyadaki basınç ile yükleme 

sırasında uygulanan basınç aynı olmayabilir.  HAD simülasyonundan çıkarılan maksimum 

ve minimum basınca ulaşmak mümkün olmayabilir. Böyle bir hataya düşmekten kaçmak 

için Ansys programında sonlu elemanlara bölünme işlemi, birkaç defe yapılmıştır. Yük 
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değişiminin oranlarının son halı ve analizde kullanılan sonlu elemanların büyüklüğü Çizelge 

6.3'te gösterilmiştir. 

Çizelge 6.3  Basınç yükü uyguladığında değişik oranı 

 
HAD 

basıncı 

Uygulanan 

basınç 

Değişik 

oranı (%) 

Sonlu Elemanların 

büyüklüğü (mm) 

Arazi eğim 

açısı (◦) 

Minimum   839.79   838.41 0.17 
30 0 

Maksimum   564.66   561.89 0.49 

Minimum   247.21   210.77 8.31 
  20.5 10 

Maksimum   818.68   813.39 0.65 

Minimum   559.97   576.71 2.99 
30 20 

Maksimum 1455.35 1450.92 0.30 

Minimum 2449.15 2456.36 0.29 
30 30 

Maksimum 2939.64 2934.77 0.17 

 

 

Şekil 6.12 Sonlu elemanların boyutlandırılması 
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Şekil 6.13 Modelin meshlenmiş hali 

6.4 Sınır Şartları 

Kolonlar 1,5 metre derinliğinde bir beton temele sahiptir. Modeli tespit etmek için 

yatay düzlemindeki kolonların alt yüzeyleri ankastre mesnet olarak kullanılmıştır. 

Simülasyon alanının sınırındaki sınır şartları FEM'in (Sonlu Elemanlar Metodunun) 

uygulanmasında önemlidir 22. 

Sınır şartları tanımlamak için Static Structural listesini sağ tıklayarak Insert > Fixed 

Support adımları takip edilir (Bkz. Şekil 6.14). Sol alt kısımda çıkan ekranda; 

Scoping Method: Geometry Selection 

Geometry: Kolonun alt yüzeyi  

Suppressed: No 

seçilir ve "Apply" tuşuna basılır (Bkz. Şekil 6.15). 
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Şekil 6.14 Sınır şartlarının tanımlama işlemi 

 

 

Şekil 6.15 Modeldeki mesnetlerin hali 
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6.5 Yük Şartları 

Önceden eklenmiş basınç dosyasını okumak için External Data modüllüdeki Setup'u 

tıklayıp sürükleyip Static Structural modülündeki Setup'a bırakılır (Bkz. Şekil 6.16). Bu 

durumda, uygulanacak basınç yükü tanımlanmış olur (Bkz. Şekil 6.17), ancak yükün 

uygulanacağı yüzeyler seçilmelidir. Burada basınç dosyası noktasal koordinatlara dayanarak 

çıkarıldığından, eklenen dosyadaki ve basıncının uygulanacağı yüzeylerdeki noktaların 

koordinatları eşleşik olmalıdır. 

Basıncının uygulanacağı yüzeyler tanımlamak için Static Structural listesindeki 

Imported Load'ı sağ tıklayarak Insert > Pressure adımları takip edilir (Bkz. Şekil 6.18). Sol 

alt kısımda çıkan ekranda; 

Scoping Method: Geometry Selection 

Geometry: Panellerin Tüm Yüzeyleri  

seçilir ve "Apply" tuşuna basılır. Sonra Imported Load listesindeki Imported Pressure'ı sağ 

tıklayarak Imported Load tuşuna basılır (Bkz. Şekil 6.19).  Şekiller 6.20 ve 6.21 yükleme 

işlemi tamamlamaktan sonra panellerin yüzeylerindeki basınç dağılımı gösterilmiştir. 

 

Şekil 6.16 Basınç yükünün harici dosyadan içeri aktarılması 
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Şekil 6.17 Tanımlanmış basınç yükünün hali 

 

 

Şekil 6.18 Basıncının uygulandığı yüzeyler tanımlaması 
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Şekil 6.19 Yük şartlarının tanımlama işlemi 

 

 

Şekil 6.20 Panellerin ön yüzeylerindeki basınç dağılımı 
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Şekil 6.21 Panellerin arka yüzeylerindeki basınç dağılımı 

6.6 Analiz Çıktılarının Belirlenmesi 

ANSYS programındaki çözüm çıktıları sayesinde, sonuçların her bir eleman için ayrı 

ayrı elde edilmesi mümkündür. Elde edilebilecek en önemli sonuçlardan biri toplam yer 

değiştirmedir. Ayrıca modelin yer değiştirme öncesi ve sonrası karşılaştırılabilir. 

Çözüm çıktılarına toplam yer değiştirme sonucunu eklemek için, Static Structural 

listesindeki Solution'ı sağ tıklayarak Insert > Deformation > Total adımları takip edilir (Bkz. 

Şekil 6.22). Sol alt kısımda çıkan ekranda; 

Scoping Method: Geometry Selection 

Geometry: İstenen Eleman  

seçilir ve "Apply" tuşuna basılır (Bkz. Şekil 6.23). 

 

 

Şekil 6.22 Toplam yer değiştirme sonucunun ekleme işlemi 
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Şekil 6.23 Toplam yer değiştirme sonucunu görmek için elemanın belirlenmesi 

Ayrıca, modelin tüm elemanlarının hala elastik bölgede olmasını sağlamak için 

gerilme sonuçları eklenebilir. Çözüm çıktılarına gerilme sonucunu eklemek için, Static 

Structural listesindeki Solution'ı sağ tıklayarak Insert > Stress > Equivalent (von-Mises) 

adımları takip edilir (Bkz. Şekil 6.24). Sol alt kısımda çıkan ekranda; 

Scoping Method: Geometry Selection 

Geometry: İstenen Eleman  

seçilir ve "Apply" tuşuna basılır (Bkz. Şekil 6.25). 

 

 

Şekil 6.24 Gerilme sonucunun ekleme işlemi 
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Şekil 6.25 Eşdeğer gerilme sonucunu görmek için elemanın belirlemesi 

Mesnetlerdeki reaksiyon sonuçları da moment ya da kuvvet olarak elde edilebilir. 

Reaksiyon sonuçlarınu eklemek için, Static Structural listesindeki Solution'ı sağ tıklayarak 

Insert > Probe > Force Reaction / Moment Reaction adımları takip edilir (Bkz. Şekil 6.26). 

Sol alt kısımda çıkan ekranda; 

Type: Force Reaction / Moment Reaction  

Location Method: Boundary Condition 

Orientation: İstenen Mesnet 

seçilir ve "Apply" tuşuna basılır (Bkz. Şekil 6.27). 

 

 

Şekil 6.26 Reaksiyon sonuçlarının ekleme işlemi 
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Şekil 6.27 Reaksiyon sonucunu görmek için mesnet belirlemesi 

Elde edilebilecek önemli sonuçlardan biri de güvenlik faktörüdür. Güvenlik 

faktörünün sonucu eklemek için, Static Structural listesindeki Solution'ı sağ tıklayarak Insert 

> Stress Tool > Max Equivalent Stress adımları takip edilir ve yeni liste eklenir (Bkz. Şekil 

6.28). Yeni eklenen listeyi tıklayarak sol alt kısımda çıkan ekranda; 

Theory: Max Equivalent Stress  

Stress limit Type: Tensile Yeild Per Material 

seçilir (Bkz. Şekil 6.29). Sonra Yeni eklenen listedeki Safety Factor'u tıklayarak sol alt 

kısımda çıkan ekranda; 

Scoping Method: Geometry Selection 

Geometry: İstenen Eleman  

seçilir ve "Apply" tuşuna basılır (Bkz. Şekil 6.30). 

 

 

Şekil 6.28 güvenlik faktörünün ekleme işlemi 
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Şekil 6.29 Güvenlik faktörünü bulmak için kullanılan çözüm yönteminin seçilmesi 

 

Şekil 6.30 Güvenlik faktörünü görmek için elemanın belirlenmesi 

Böylece kontrol edilecek çözümün tüm çıktıları eklenmiştir. Ancak, çözüm yaptıktan 

sonra bile herhangi bir sonuç eklenmesi ya da değiştirilmesi mümkündür. Eklenen ya da 

değiştirilen sonuçları, sağ tıklayarak "Evaluate All Results" in komutu ile çözümü 

tekrarlamaya gerek kalmadan değerlendirilebilir (Bkz. Şekil 6.31). 

 

 

Şekil 6.31 Eklenen ya da değiştirilen sonuçlarının değerlendirilmesi 
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Nihayet programa çözmek için bir komut verilir. Proje köşesinde herhangi bir 

noktada sağ tıklayarak Solve (F5)'i basılır (Bkz. Şekil 6.32). Program çözmeyi bitirene kadar 

beklenir. Çözüm hızının girilmiş verilerinin yoğunluğuna bağlı olduğu vurgulanmalıdır. 

Çözüm ağı ne kadar küçük olursa, çözme o kadar karmaşık olur ve o kadar uzun sürer. 

 

 

Şekil 6.32 Analizin başlatılması 
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7 SONUÇLAR VE KARŞILAŞTIRMA 

Bu çalışmada, Şanlıurfa Siverek ilinde bulunan elektrik üretim projesinin bir örneği 

alınmıştır. Arazi eğilimlerin güneş sistemi üzerindeki etkisini incelemek için, aşağıdakilere 

göre dört model hazırlanmıştır. 

1. Düz arazi uygulamalı model 

2. 10° eğimli arazi uygulamalı model 

3. 20° eğimli arazi uygulamalı model 

4. 30° eğimli arazi uygulamalı model 

Modeller iki aşamada analiz edilmiştir. 

• Birinci Aşama:  

Bu aşamada 28 km/s rüzgâr hızının etkisi altında güneş panellerinin HAD 

simülasyonu yapılmıştır. Ardışıklığın paneller üzerindeki etkisini göz önünde bulundurmak 

için, beşe kadar arka arkaya panellerin sıraları yerleştirilmiş. Bu durumda, bu aşamadaki 

model sayısı 20 olmuştur. Her model aşağıdaki gibi beş modele ayrılmıştır. 

1. Tek sıra. 

2. Arka arkaya iki sıra.   

3. Arka arkaya üç sıra.  

4. Arka arkaya dört sıra.  

5. Arka arkaya beş sıra. 

Bu aşamada, güneş panelleri üzerindeki basınç dağılımı, yük uygulaması sırasında 

ikinci aşamada daha sonra kullanmak için bir Excel dosyası olarak ihraç edilmiş. 

• İkinci aşama 

Bu aşamada tüm modelin doğrusal olmayan bir statik analizi yapılmıştır. Simülasyon 

yapıldıktan sonra çoğu modelde en yüksek basınç farkına maruz kalan ilk güneş panelleri 

sırası gözlenmiş ve maksimum basınç her zaman ilk panel sıralarında toplanmıştır. Bunun 

için bu aşamada sadece tek duran modeller alınmıştır. Sonuç olarak, bu aşamadaki model 

sayısı aşağıdaki gibi sadece 5'tir. 

1. Düz arazi uygulamalı tek sıra 

2. 10° eğimli arazi uygulamalı tek sıra 
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3. 20° eğimli arazi uygulamalı tek sıra 

4. 30° eğimli arazi uygulamalı tek sıra 

7.1 HAD Simülasyonu Sonuçları 

Bu bölümde, HAD simülasyonu sonuçları sadece düz arazi uygulamalı model için 

gösterilmiştir. Eğimli arazi uygulamalı modellerin HAD sonuçları ekler A, B ve C'de 

bulunmuştur. Simülasyon yapıldıktan sonra güneş panelleri üzerindeki basınç dağılımı elde 

edilmiş. Basınç dağılımı 7.1'den 7.5'ye kadar kontur Şekillerinde gösterilmiştir. Ancak her 

şekilde iki görüntü vardır; üst görüntü panellerin ön yüzeyleri üzerindeki basınç dağılımı 

için ve alt görüntü ise panellerin arka yüzeyleri üzerindeki basınç dağılımı içindir.  

 

 

Şekil 7.1 Düz arazi; tek sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil 7.2 Düz arazi; iki sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil 7.3 Düz arazi; üç sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil 7.4 Düz arazi; dört sıralı güneş paneller üzerindeki basınç dağılımı 

 
 

Şekil 7.5 Düz arazi; beş sıralı güneş paneller üzerindeki basınç dağılımı 
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Rüzgârın güneş panelleri etrafında nasıl estiğini iyi anlamak için, akış çizgisi dikkate 

alınmıştır. Akış çizgisi, güneş panelleri sırasının ortasında vektör olarak düz arazi 

uygulamalı model için 7.6'den 7.10'ye kadar Şekillerde gösterilmiştir. Eğimli arazi 

uygulamalı modellerin akış çizgileri ekler A, B ve C'de bulunmuştur.   

 

Şekil 7.6 Düz arazi; tek sıralı güneş paneller üzerindeki akış çizgisi 

 

Şekil 7.7 Düz arazi; iki sıralı güneş paneller üzerindeki akış çizgisi 



77 

 

 

 

Şekil 7.8 Düz arazi; üç sıralı güneş paneller üzerindeki akış çizgisi 

 

Şekil 7.9 Düz arazi; dört sıralı güneş paneller üzerindeki akış çizgisi 

 



78 

 

 

 

Şekil 7.10 Düz arazi; beş sıralı güneş paneller üzerindeki akış çizgisi 

Basınç kontur şekilleri ve akış çizgileri incelendikten sonra, aşağıdaki sonuçlara 

varılmış. 

1. Panel sıralarının sayısını arttırırken ilk panel sırasının basınç dağılımından en büyük 

paya sahip olduğu görülmüştür. Azami basınç değerleri, ilk sıranın sonraki sıralara 

göre daha geniş alanlarına dağıtılmıştır. Başka bir deyişle, ilk sıra rüzgârın diğer 

sıralara doğru ilerlemesini engelleyerek rol oynamaktadır. İncelenen dört modelde 

oluşan rüzgâr basıncının maksimum ve minimum değerleri Çizelgeler 7.1, 7.2, 7.3 

ve 7.4'te gösterilmiştir. 

Çizelge 7.1  Düz arazi; maksimum ve minimum basınç değerleri (Pa) 

Sıra No 
Ekstrem 

Değerler 

Sıra Adedi 

1 2 3 4 5 

1 
Max 564.66 547.38 565.53 560.77 564.57 

Min -839.79 -858.23 -820.73 -811.27 -793.96 

2 
Max  164.35 165.94 182.92 203.52 

Min  -963.85 -882.16 -829.80 -797.77 

3 
Max   372.14 386.45 382.13 

Min   -902.80 -793.21 -700.88 

4 
Max    378.08 383.60 

Min    -850.23 -722.69 

5 
Max     392.11 

Min     -829.78 
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Çizelge 7.2  10° eğimli arazi; maksimum ve minimum basınç değerleri (Pa) 

Sıra No 
Ekstrem 

Değerler 

Sıra Adedi 

1 2 3 4 5 

1 
Max  818.68 812.68 808.61 809.93  805.41 

Min -247.21 -337.05 -235.99 -123.22 -200.76 

2 
Max   502.39  466.36  474.89  471.69 

Min  -186.74 -117.75 -130.41 -131.33 

3 
Max    549.14  541.81  531.95 

Min   -520.42 -426.24 -400.86 

4 
Max     558.88  563.56 

Min    -572.61 -562.61 

5 
Max      563.98 

Min     -557.68 

 

Çizelge 7.3   20° eğimli arazi; maksimum ve minimum basınç değerleri (Pa) 

Sıra No 
Ekstrem 

Değerler 

Sıra Adedi 

1 2 3 4 5 

1 
Max 1455.35  1459.86 1450.76 1452.15 1454.67 

Min   559.97   608.06   584.14   703.95   664.22 

2 
Max   1280 1288.73 1268.06 1280.90 

Min    630.99   655.83   633.40   606.29 

3 
Max   1169.16 1170.18 1172.21 

Min     578.61   484.49   491.12 

4 
Max    1160.77 1174.08 

Min      511.91   631.12 

5 
Max     1148.72 

Min       627.72 
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Çizelge 7.4  30° eğimli arazi; maksimum ve minimum basınç değerleri (Pa) 

Sıra No 
Ekstrem 

Değerler 

Sıra Adedi 

1 2 3 4 5 

1 
Max 2939.64 2941.96 2943.50 2942.15 2939.12 

Min 2449.15 2466.27 2462.88 2498.55 2448.05 

2 
Max  2820.16 2815.16 2824.25 2814.65 

Min  2452.84 2459.42 2476.67 2483.02 

3 
Max   2746.19 2752.06 2748.56 

Min   2429.67 2442.02 2414.08 

4 
Max    2694.50 2694.29 

Min    2426.01 2441.18 

5 
Max     2652.34 

Min     2434.70 

 

Maksimum ve minimum değerler arasındaki basınç farkı göz önüne alındığında ve 5 

sıra arka arkaya yerleştirilmesi durumunda, ilk sıradaki basınç farkının, çoğu durumda, Şekil 

7.11, 7.12, 7.13 ve 7.143'te gösterildiği gibi en büyük olduğu görülmüştür. 

 

Şekil 7.11 Düz arazi; maksimum ve minimum basınç farkları 
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Şekil 7.12 10° eğimli arazi; maksimum ve minimum basınç farkları 

 

 

Şekil 7.13 20° eğimli arazi; maksimum ve minimum basınç farkları 
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Şekil 7.14 30° eğimli arazi; maksimum ve minimum basınç farkları 

2. Düz ve 10° eğimli arazi uygulamalarında, panellerin arka yüzlerindeki bazı 

bölgelerde negatif basınç gözlenmiştir.  Bu durumda paneller ön yüzlerinin basınç 

kuvvetine, arka yüzlerinin emme ve basınç kuvvetlerine maruz kaldığı anlamına 

gelir. Böylece paneller üzerindeki basınç farklılıkları artar. Başka bir deyişle, taşıyıcı 

yapıya daha tehlikeli bir yükleme durumu oluşacaktır. 

3. 20° ve 30°eğimli arazi uygulamalarında, panellerin yüzlerinde hiç negatif basınç 

gözlenmemiştir. Sadece pozitif basınç gözlenmiştir. Bu durumda panel yüzlerinin 

sadece basınç kuvvetlerine maruz kaldığı anlamına gelir. Bu nedenle, arka yüzdeki 

basınç, ön yüzdeki basınca direnç göstermede rol oynayacaktır. Böylece paneller 

üzerindeki basınç farklılıkları azalacak, başka bir deyişle, taşıyıcı yapıya daha hafif 

bir yükleme durumu oluşacaktır. 

4. Dört modeldeki tek başına duran panellerde oluşan basınç farkları incelenerek Şekil 

7.15 ve 7.16'da gösterildiği gibi arazi eğim açısının artmasıyla daha düşük basınç 

farkı gözlenmiştir. Yani, arazinin eğik yüzeyi de rüzgâr direncinde bir rol oynar. 

Böylece arazinin eğim açısını arttırmak, taşıyıcı yapı üzerindeki rüzgâr yükünü 

azalttırır. 
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Şekil 7.15 Tek başına duran panellerde oluşan basınç farkları 

 

Şekil 7.16 Arazinin eğim açısına göre basınç farkından, tek başına duran panellerin 
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7.2 Statik Analizi Sonuçları 

Analiz bittikten sonra, taşıyıcı yapıdaki ortaya çıkan toplam yer değiştirme sonuçları 

elde edilmiş. Toplam yer değiştirme 7.17'den 7.20'ye kadar Şekillerde gösterilmiştir. 

 

Şekil 7.17 Düz arazi; toplam yer değiştirme 

 

Şekil 7.18 10° eğimli arazi; toplam yer değiştirme 
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Şekil 7.19 20° eğimli arazi; toplam yer değiştirme 

 

Şekil 7.20 30° eğimli arazi; toplam yer değiştirme 

Çizelge 6.10'da gösterilen modellerin toplam yer değiştirme değerleri incelenerek, 

arazinin eğim açısı arttıkça yer değiştirme değerlerinin nasıl azaldığı açıkça gözlenmiştir. 

Arazinin eğim açısı arttıkça yer değiştirmedeki değişimi Şekil 7.21 gösterilmiştir. 
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Şekil 7.21 Yer değiştirmedeki değişimi 

Çizelge 7.5  Statik analizi sonuçları 

Arazi eğim 

açısı 

Toplam yer 

değiştirme 

(mm) 

Eşdeğer gerilme (MPa) Güvenlik katsayısı 

Maksimum Minimum Minimum Maksimum 

0 2.13 45.13 0.0017   5.54 15.00 

10 1.66 35.68 0.0004   7.01 15.00 

20 0.84 24.43 0.0006 10.23 15.00 

30 0.29 11.30 0.0001     15.00 15.00 

 

Taşıyıcı yapının tüm elemanları elastik bölgesinde kalmasını kontrol etmek için 

eşdeğer gerilme sonuçları dikkate alınmıştır. Eşdeğer gerilme sonuçları 7.22'den 7.25'e kadar 

Şekillerde ve Çizelge 7.5'te gösterilmiştir. 
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Şekil 7.22 Düz arazi; eşdeğer gerilme 

 

Şekil 7.23 10° eğimli arazi; eşdeğer gerilme 
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Şekil 7.24 20° eğimli arazi; eşdeğer gerilme 

 

Şekil 7.25 30° eğimli arazi; eşdeğer gerilme 
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Çizelge 7.5'te gösterilen modellerin maksimum eşdeğer gerilme değerlerini 

inceleyerek, arazinin eğim açısı arttıkça eşdeğer gerilme değerlerinin nasıl azaldığı açıkça 

gözlenmiştir. Arazinin eğim açısı arttıkça maksimum eşdeğer gerilmedeki değişimi Şekil 

7.26 gösterilmiştir. 

 

 

Şekil 7.26 Maksimum eşdeğer gerilmedeki değişimi 

 

Modellerin taşıyıcı yapılarının dayanıklılığını ve uygulanan rüzgâr kuvvetine karşı 

direncini kontrol etmek için güvenlik katsayısı göz önünde bulundurulmuştur. Güvenlik 

katsayısı 7.27'den 7.30'a kadar Şekillerde ve Çizelge 7.5'te gösterilmiştir. 

0

5

10

15

20

25

30

35

40

45

50

0 10 20 30

M
ak

si
m

u
m

 g
er

il
m

e
(M

p
a)

Eğim açısı (◦)



90 

 

 

 

Şekil 7.27 Düz arazi; güvenlik katsayısı 

 

Şekil 7.28 10° eğimli arazi; güvenlik katsayısı 
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Şekil 7.29 20° eğimli arazi; güvenlik katsayısı 

 

Şekil 7.30 30° eğimli arazi; güvenlik katsayısı 
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Çizelge 7.10'da gösterilen modellerin maksimum güvenlik katsayısı değerlerini 

inceleyerek, arazinin eğim açısı arttıkça güvenlik katsayısı değerlerinin nasıl arttığı açıkça 

gözlenmiştir. Arazinin eğim açısı arttıkça minimum güvenlik katsayısındaki değişimi Şekil 

7.31 gösterilmiştir. 

 

 

Şekil 7.31 Minimum güvenlik katsayısındaki değişimi 

Rüzgârın tüm güneş sistemini taşıyan beton temeli üzerindeki etkisini incelemek için 

modellerin yüklenmesinden kaynaklanan reaksiyon kuvvetleri ve momentleri elde 

edilmiştir. Reaksiyon değerleri Çizelge 7.6 ve 7.7'de gösterilmiştir. 

Çizelge 7.6  Reaksiyon kuvvetleri (N) 

Arazi Eğim Açısı 
Mesnet Adı 

A B C D E 

0 2150.30 3032.50 3019.20 3022.8 2050.30 

10 1568.30 2174.30 2075.60 2176.3 1585.90 

20 1087.40 1537.30 1517.40 1611.5 1231.70 

30   466.35   627.23   603.23   632.9   433.61 
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Çizelge 7.7  Reaksiyon momentleri (N.mm) 

Arazi Eğim Açısı 
Mesnet Adı 

A B C D E 

0 1.05E+06 1.05E+06 1.07E+06 1.05E+06 9.64E+05 

10 7.92E+05 8.08E+05 7.99E+05 7.93E+05 7.39E+05 

20 4.21E+05 4.50E+05 4.47E+05 4.52E+05 4.20E+05 

30 1.05E+05 1.02E+05 9.05E+04 8.55E+04 6.51E+04 

 

Çizelge 7.6 ve 7.7'de gösterilen modellerin reaksiyon değerlerini inceleyerek, 

arazinin eğim açısı arttıkça reaksiyon kuvvetleri ve momentlerinin nasıl azaldığı açıkça 

gözlenmiştir. Arazinin eğim açısı arttıkça reaksiyon kuvvetleri ve momentlerindeki 

değişimi Şekil 7.32 ve 7.33'te gösterilmiştir. 

 

 

Şekil 7.32 Mesnetlere göre reaksiyon kuvvetlerindeki değişimi 
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Şekil 7.33 Mesnetlere göre reaksiyon momentlerindeki değişimi 

HAD simülasyonu ve statik analizi sonuçlarını araştırıp kontrol ettikten sonra, 

aşağıdaki noktalar özetlenebilir 

1. Düz arazi durumunda, panel sıraları sayısı arttıkça ilk ve son sıralardaki basınç 

farkının, orta sıralardan daha büyük olduğunu fark edilmiştir. 

2. Düz olmayan arazi durumunda, arazinin eğim açısı arttıkça basınç farkı ilk sıralarda 

mümkün olduğu kadar büyüktü ve ertesi sıralarda kademeli olarak düşmüştür. 

3. Çoğu durumlarda, basınç dağılımının en büyük payı ilk sıralardadır. Bu nedenle ilk 

sıranın, rüzgârın ilerlemesini önlemede ve ertesi sıralara yükünü azaltmasında rol 

oynadığını söylemek mümkündür. 

4. Rüzgâr Yükü, arazinin eğim açısı arttıkça belirgin bir şekilde azalmıştır. Taşıyıcı 

yapı üzerindeki rüzgâr yükünden kaynaklanan toplam yer değiştirme ve eşdeğer 

basınç değerlerinin azaltıldığı fark edilmiştir. Başka bir deyişle, taşıyıcı profillerin 

kesitleri küçültebilir. 

5. Arazinin eğim açısı panellerin eğim açısına yaklaştığında, daha düzenli ve istikrarlı 

girdaplar ile akış kararlılığı gözlenmiştir. 
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7.3 Karşılaştırma 

Bu bölümde, bazı standartlardaki basınç dağılımını hesaplamak için kullanılan 

basınç katsayısı karşılaştırılmıştır. Her standart yüzeydeki net basıncı hesaplamak için 

denklem 7-1'i kullanır. 

𝑤 = 𝐶𝑝. 𝑞 (7-1) 

Burada; 

𝑤: Net basınç 

𝑞 : Rüzgâr basıncı  

𝐶𝑝: Basınç katsayısı 

7.3.1 Türk standardı (TS-498) 

Rüzgâr basıncı, yapının yüksekliğe bağlı olarak standarttaki çizelge 5’ten alınır. 

Elimizdeki güneş sisteminin yüksekliği 8 metreden az olduğu için, rüzgâr basıncı 𝑞 =

0,5 𝑘𝑛/𝑚2olmuştur.  

Basınç katsayısı, yapı cinsine göre standarttaki çizelge 6 ile verilmiştir. Güneş 

panellerine en benzer olan bina cinsi "Taşıyıcı sistemler ve taşıyıcı dolu duvarlar" ’ın 2.2-b-

II kısmında bulunur. Buna göre, panellerdeki net basınç katsayısı 𝐶𝑝 = 1,2 sin 𝛼 olmuştur.  

Burada; 𝛼 Güneş panellerinin eğim açısı ve elimizdeki güneş panelleri için 𝛼 = 30°’dir. 

Dolayısıyla, basınç katsayısının Türk standardına göre değeri 𝐶𝑝 = 0.6 'dır. 

7.3.2 Avrupa standardı (EN 1991-1-4) 

Rüzgâr basıncı, hesaplamak için denklem 7-2'i kullanılır. 

𝑞 = [1 + 7𝐼𝑣,𝑧].
1

2
𝜌. 𝑣𝑚,𝑧

2 
(7-2) 

Burada; 

𝜌 : Hava yoğunluğu (1,25 kg/m3  ). 

𝐼𝑣,𝑧: Türbülans şiddeti. Denklem 7-3 ile verilir. 

𝐼𝑣,𝑧 =
𝐾1

𝐶𝑜,𝑧. ln
𝑧
𝑧0

 
(7-3) 

Burada; 

𝑧0: EN 1991-1-4 Tablo 4.1'de verilen pürüz uzunluğu. Güneş enerjisi projeleri için en iyi 

arazi kategorisi 𝐼𝐼𝐼. Buna göre 𝑧0 = 0.3 m , 𝑧𝑚𝑖𝑛 = 3 𝑚 ve genelde 𝑧𝑚𝑎𝑥 = 200 𝑚 alınır. 
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𝑍: yapı yüksekliği (≈ 2,3 𝑚) 

𝐶𝑜,𝑧: orografi faktörü. Orografik araziyi dikkate alır. Ancak sadece düz arazi üzerinde oluşan 

basıncın karşılaştırılacağı için bu faktör 1 olarak alınır. 

𝐾1: türbülans faktörüdür ve önerilen değer 1’dir. 

⇒ 𝐼𝑣,𝑧 =
1

1. ln
2.3
0.3

= 0.491 

𝑣𝑚,𝑧: elemanların yüksekliğine göre ortalama rüzgâr hızı. Denklem 7-4 ile verilir. 

𝑣𝑚,𝑧 = 𝐶𝑟,𝑧 . 𝐶𝑜,𝑧 . 𝑣𝑏 (7-4) 

𝐶𝑟,𝑧: pürüzlülük faktörü. Denklem 6 – 5 ile verilir. 

  𝑧 ≤ 𝑧𝑚𝑖𝑛 𝑖ç𝑖𝑛,    𝐶𝑟,𝑧 = 𝑘𝑟 . ln
𝑧𝑚𝑖𝑛

𝑧0
  (7-5) 

𝑘𝑟 : arazi faktörü. Pürüzlülük uzunluğuna bağlı olarak 𝑧0 kullanılarak denklem 7-6 ile 

hesaplanır. 

𝑘𝑟 = 0.19 (
𝑧0

𝑧0,𝐼𝐼
)

0.07

 
(7-6) 

⇒ 𝑘𝑟 = 0.19 (
0.3

0.05
)
0.07

= 0.215 

⇒ 𝐶𝑟,𝑧 =  0.215. ln
3

0,3
= 0.437 

𝑣𝑏: temel rüzgâr hızı. Karşılaştırma için, analiz sırasındaki kullanılan aynı hız kullanılmıştır 

𝑣𝑏 = 28 𝑚/𝑠.  

⇒ 𝑣𝑚,𝑧 = 0.437. 1 .28 = 12.236 𝑚/𝑠 

⇒  𝑞 = [1 + 7(0,491)].
1,25

2
. 12.236 2 = 415.19 N/𝑚2

= 0.415 𝐾𝑁/𝑚2 

Basınç katsayısını hesaplamak için standarttaki Tablo 7-6 kullanılmıştır. Elimizdeki 

güneş panelleri EN 1991-1-4 / 7.2 bölümündeki belirtilen kanopi çatılar ile 

karşılaştırılmıştır. Basınç katsayısının değerleri, 𝜃 çatının eğim açısına ve 𝜑 blokaj 

katsayısına göre verilmiştir. Ancak burada basınç katsayısı, Şekil 7.34'teki gibi yüzeye 

dağılmıştır. Bu nedenle, karşılaştırma amacıyla, basınç katsayılarının aritmetik ortalaması 

alınacaktır. 
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Şekil 7.34 Avrupa standardına göre yüzeydeki basınç katsayısı dağıtımı 23  

Elimizdeki güneş panelleri için 𝜃 = 30° , 𝜑 = 0  dır. Bu nedenle, panellerin ön 

yüzündeki basınç katsayısının değerleri;  

A bölge için +2.2 

B bölge için +3.2 

C bölge için +2.4 

ve arka yüzündeki basınç katsayısının değerleri; 

A bölge için -3 

B bölge için -3.8 

C bölge için -3.6 dır. + ve - değerler, sırasıyla aşağı ve yukarı doğru hareket eden rüzgâr 

temsil eder. Basınç bölgelerine göre aritmetik ortalama kullanarak basınç katsayısı aşağıdaki 

gibi bulunur. 

A bölge alanı = 23.0461 m2 

B bölge alanı = 2.8808 m2 

C bölge alanı = 2.8808 m2 

Toplam alan = 36.0096 m2 

𝐶𝑝 =
(𝐶𝐴.  𝐴𝑙𝑎𝑛𝐴) + 2 . (𝐶𝐵.  𝐴𝑙𝑎𝑛𝐵) + 2 . (𝐶𝐶 .  𝐴𝑙𝑎𝑛𝐶) − (𝐶𝐴

′.  𝐴𝑙𝑎𝑛𝐴) − 2 . (𝐶𝐵
′.  𝐴𝑙𝑎𝑛𝐵) − 2 . (𝐶𝐶

′.  𝐴𝑙𝑎𝑛𝐶)

6 .  𝐴𝑙𝑎𝑛𝑡𝑜𝑝𝑙𝑎𝑚
 

=
(2.2 .  23.0461) + 2 . (3.2 .  2.8808 ) + 2 . (2.4 .  2.8808) − (3 .  23.0461) − 2 . (3.8 .  2.8808 ) − 2 . (3.6 .  2.8808)

6 .  36.0096
 

= −0.1333  

7.3.3 Amerikan standardı (ASCE7) 

Amerikan standardına göre açık Binalarda Rüzgâr Yükünü Belirleme Adımları 

aşağıdadır: 
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- Adım 1: Risk kategorisini belirlemek. Standarttaki Tablo 1.5-1’e göre santrallerin 

projeleri sınıf III düşünülebilir. Çünkü başarısızlığı büyük bir ekonomik etkiye veya 

sivil hayatın bozulmasına neden olabilir.  

- Adım 2: Uygulanan risk kategorisine göre temel rüzgâr hızı belirlemek. Ancak 

karşılaştırma için, analiz sırasındaki kullanılan aynı hız kullanılmıştır V=28 m/s. 

- Adım 3: Rüzgâr yükü değişkenlerini belirlemek. 

1- Rüzgâr doğrultu faktörü (𝐾𝑑). Bu faktör sadece yük kombinasyonları ile birlikte 

kullanıldığında uygulanır. Bu nedenle projemiz için 𝐾𝑑 = 1’dir. 

2- Maruz kalma kategorisi. Standardın bölüm 26.7’sine göre elimizdeki paneller 

için maruz kalma kategorisi C’dir. 

3- Topoğrafya etki faktörü (𝐾ℎ𝑡). Standardın bölüm 26.8’ine göre eğer genel 

topoğrafide ani değişiklikler varsa topoğrafya etki katsayısı standartta belirlemiş 

denklem ile hesaplanır. Aksi durumlarda topoğrafik faktör 1 alınır. Standardın 

şekil 26.8-1’ine göre elimizdeki paneller için topoğrafya etki faktörü 𝐾ℎ𝑡 = 1 

’dir. 

4- Fırtına etki faktörü (G). Standardın bölüm 26.9’una göre 0,85 olarak alınmasına 

izin verilir. 

- Adım 4: Rüzgâr basıncı maruz kalma katsayısını (𝐾ℎ) belirlemek. Standardın 

çizelge 30.3-1’ine göre elimizdeki panellerin yüksekliği ve maruz kalma 

kategorisini için 𝐾ℎ = 0.85 ’tir. 

- Adım 5: Hız basıncını (𝑞ℎ) belirlemek. Bunun için denklem 7-7'i kullanılır. 

𝑞ℎ = 0.613  𝐾ℎ 𝐾ℎ𝑡 𝐾𝑑 𝑉
2 (7-7) 

⇒ 𝑞ℎ = 0.613 . 0.85 . 1 . 1 . 282 = 408.50 𝑁/𝑚2 = 0.4085 𝐾𝑁/𝑚2 

- Adım 6: Net basınç katsayıları (𝐶𝑁) belirlemek. Standarttaki şekil 30.8-1, tek eğimli 

serbest çatılar için net basınç katsayısı verir. Bu tür çatılar, güneş panellerin çok 

benzediği için net basınç katsayısını kullanılmıştır. Burada, yüzey Şekil 7.35'te gibi 

bölgelere ayrılır. Her bölümün alanına göre bu alanda etkileyecek net basınç 

katsayısı bulunur.  
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Şekil 7.35 Amerikan standardına göre yüzeydeki basınç katsayısı dağıtımı 24 

Bölgelerin etkili alanını bulmak için aşağıdaki kontrolleri yapılmıştır: 

0.25 ≤ (
ℎ

𝐿
=

1.45

2.9
= 0.5) ≤ 1 

4% . 𝐿 = 0.04 . 2.9 = 0.116 𝑚

0.9 𝑚
} ≤ 𝑎 = 𝑚𝑖𝑛𝑖𝑚𝑢𝑚 {

10% . 𝐿 = 0.29
0.4 ℎ = 0.4 . 1.45 = 0.58

 

⟹ 𝑎 = 0.9 𝑚 

Elimizdeki paneller a = 0,9 çıktığı için sadece iki bölgeye (1,2) bölünecek. Bu iki bölgenin 

alanı: 

𝐴1 = 10.23 𝑚2   >   4 𝑎2 = 3.24 𝑚2 

𝐴2 = 21.96 𝑚2   >   4 𝑎2 = 3.24 𝑚2 

Buna göre bölgelerin iki yüzünün net basınç katsayılarının aynı olduğu bulunmuştur. Başka 

bir deyişle, basınç yüzeylere tutarlı dağılacaktır. Sonunda, panellerin ön yüzündeki net 

basınç katsayısı +2,6 ve arka yüzündeki net basınç katsayısı -2,5 olarak bulunmuştur. Artı 

işareti, üst çatı yüzeyine doğru hareket eden basınçları ifade eder. Eksi işareti, üst çatı 

yüzeyinden uzağa hareket eden basınçları ifade eder. Bu nedenle, ortalama net basınç 𝐶𝑁 =

2.6 − 2.5 = 0.1’dir.  

Tek eğimli çatılara sahip açık binaların bileşen elemanları için net tasarım rüzgâr 

basıncı, aşağıdaki denklemde belirlenir. 

𝑝 = 𝑞ℎ 𝐺 𝐶𝑁 (7-8) 

Ancak diğer standartlarla karşılaştırabilmek için 𝐺 𝐶𝑁 = 𝐶𝑝 olarak alınmıştır. Buna göre 

𝐶𝑝 = 0.85 . 0.1 = 0.085 olarak bulunur.  
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7.3.4 HAD sonuçlarına göre 

Standartlarda, önce basınç katsayısı ve rüzgâr tasarım basıncı hesaplanır daha sonra 

net basınç yüzeylere uygulanır. Panellere basınç uygulandıktan sonra yapı analiz edilir ve 

reaksiyonlar hesaplanır.  

Fakat yapılan analizlerde, basınç katsayısı ters yol ile bulunmuştur. Kuvvet reaksiyonları ele 

aldıktan sonra, değerleri toplanarak ve panellerin toplam alanına bölerek panellere etki eden 

net basınç elde edilmiştir.  Bu durumda, tek duran panellerinin yüklenmesinden kaynaklanan 

reaksiyonlar alındı. Tüm modeller için panellerdeki net basıncı Çizelge 7.8'de gösterilmiştir. 

Çizelge 7.8  Tüm modeller için panellerdeki net basıncı 

Arazi eğim açısı 

derece 

Reaksiyon toplamı 

(kN) 

Paneller alanı 

(m2) 

Net basıncı (w) 

(kN/m2) 

0 13.2751 36 0.3687 

10   9.5804 36 0.2661 

20   6.9853 36 0.1940 

30   2.7633 36 0.0767 

 

Standartlarda kullanılan basınç katsayısının değerini doğrulamak için standardın aynı 

rüzgâr basıncı kullanılmıştır. Simülasyondan kaynaklanan basınç katsayısını elde etmek için 

yukarıdaki elde edilen net basınç değerleri, standardın elde edilen basınç değerlerine 

bölünmüştür. Simülasyonlardan kaynaklanan basınç katsayıları standartlara göre Çizelge 

7.9, 7.10 ve 7.11'de gösterilmiştir. 

Çizelge 7.9  Türk standardının rüzgâr basıncına göre simülasyonlardan kaynaklanan basınç 

katsayıları 

Standardın 

Basınç 

Katsayısı (C) 

Standardın 

Rüzgâr Basıncı 

(q) 

Analize 

Göre Basınç 

Katsayısı 

Analizin Net 

Basıncı 

(w) 

0.6 0.5 0.7373 0.3687 

0.6 0.5 0.5321 0.2661 

0.6 0.5 0.3880 0.1940 

0.6 0.5 0.1535 0.0767 
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Çizelge 7.10  Avrupa standardının rüzgâr basıncına göre simülasyonlardan kaynaklanan 

basınç katsayıları 

Standardın 

Basınç 

Katsayısı (C) 

Standardın 

Rüzgâr Basıncı 

(q) 

Analize 

Göre Basınç 

Katsayısı 

Analizin Net 

Basıncı 

(w) 

-0.1333 0.415 0.8883 0.3687 

-0.1333 0.415 0.6411 0.2661 

-0.1333 0.415 0.4674 0.1940 

-0.1333 0.415 0.1849 0.0767 

Çizelge 7.11  Amerikan standardının rüzgâr basıncına göre simülasyonlardan kaynaklanan 

basınç katsayıları 

Standardın 

Basınç 

Katsayısı (C) 

Standardın 

Rüzgâr Basıncı 

(q) 

Analize 

Göre Basınç 

Katsayısı 

Analizin Net 

Basıncı 

(w) 

0.085 0.4085 0.9025 0.3687 

0.085 0.4085 0.6513 0.2661 

0.085 0.4085 0.4749 0.1940 

0.085 0.4085 0.1879 0.0767 

 

Yukarıdaki çizelgeler kontrol edilerek aşağıdaki sonuçlara ulaşılmıştır: 

1- Türk standardına göre, basınç tüm yüzeye tutarlı bir şekilde dağıtılmaktadır. Bunun 

simülasyon sonuçlarına aykırı olduğu görülmüştür. 

2- Avrupa standardına göre, yüzeydeki basınç dağılımı değişkendir ve yüzey 

bölgelerine göre dağıtılmıştır. Bu durum simülasyon sonuçlarıyla biraz uyumludur.  

3- Amerikan standardına göre, yüzeydeki basınç dağılımı genelde değişkendir. Ancak 

elimizdeki verilere göre, basınç dağıtımı sabit bir şekle dönüşmüştür ve bunun 

simülasyon sonuçlarına aykırı olduğu görülmüştür. 

4- Türk ve Amerikan Standardına göre basınç katsayısı pozitiftir, bu da rüzgârın 

panellere doğru basınç oluşturduğu anlamına gelmektedir. Bu durum, simülasyon ve 

deney tarafından oluşturulan yük durumu ile uyumludur. 

5- Avrupa Standardına göre basınç katsayısı negatiftir, bu da rüzgârın kaldırma 

oluşturduğu anlamına gelmektedir. Bunun nedeni, panellerin arka yüzeylerindeki 

Standarttaki basınç katsayısının ön yüzeylerden daha büyük olmasıdır. Bu durum, 

simülasyon ve deney tarafından oluşturulan yük durumu ile uyumsuzdur. 
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6- İncelenen standartlar için, simülasyondan kaynaklanan basınç katsayısının 

standarttaki basınç katsayısından bir dereceye kadar büyük olduğu görülmüştür. 

Başka bir deyişle, standart tarafından verilen basınç katsayısı güvensiz olabilir. 

7- Analizden kaynaklanan basınç katsayısının, arazi eğim açısının artmasıyla azaldığı 

da gözlenmiştir. Standartta verilen basınç katsayısı sabit kalmıştır ve arazinin eğim 

açısındaki değişiklikten etkilenmemiştir. 

8- Amerikan standardı, rüzgâr tüneli testinin özel yapılar için kullanıldığını belirtir 25. 

Enerjisi santrallerindeki güneş panelleri bu özel yapılar arasında düşünülebilir. Bu 

nedenle, bu panelleri tasarlamak için en iyi çözüm, rüzgâr tüneli testine benzeyen 

simülasyon yöntemlerini kullanmaktır. 

9- Basınç katsayıları ışığında, Türk standardı, Amerikan standardı, simülasyon ve 

deneyden kaynaklanan basınç katsayılarının hepsinin basınç durumu verdiği 

görülmüştür. Ancak Avrupa standardından kaynaklanan basınç katsayısının kaldırma 

durumu verdiği görülmüştür. 

10- Basınç katsayısı, arazinin eğim açısına göre değişir, bu yüzden standartlar rüzgâr 

hesabında bunu dikkate almalıdır. 

  



103 

 

 

KAYNAKLAR 

[1] Söylemez, F. (N.D.). Güneş Enerji Sistemleri (GES). (Erişim Tarihi: 10.05.2019) 

Https://Www.Linkedin.Com/Pulse/Güneş-Enerji-Sistemleri-Ges-Fatih-Soylemez. 

(2017) 

[2] Charabi, Y., Rhouma, M. B. H., & Gastli, A. (2016). Siting Of PV Power Plants On 

İnclined Terrains. International Journal Of Sustainable Energy, 35(9), 834-843. 

[3] USLU, V. E. (2014). Computational Fluid Dynamic Analysis Of Wind Loads Acting On 

Ground Mounted Solar Panels (Doctoral Dissertation, M. Sc. Thesis, 117 Pp., Nat. 

Appl. Sci., Middle East Technical Univ., Turkey). 

[4] Assmus, M., & Koehl, M. (2012). Experimental İnvestigation Of The Mechanical 

Behavior Of Photovoltaic Modules At Defined İnflow Conditions. Journal Of 

Photonics For Energy, 2(1), 022002. 

[5] Raghuvendra Singh Som, Rishabh Sharma, Harshit Tripathi. (2016). Stability And Stress 

Analysis Of Solar Array Structure. IJATES International Journal Of Advanced 

Technology İn Engineering And Science, 2348-7550. 

[6] Y. MÜH. İbrahim Koç Hesaplamalı Akışkanlar Dinamiği Ders Notları (2014). 

[7] Karaoğlu, İ., Cn-235 Casa Uçağı Kıvrık Kanat Tasarımının Hesaplamalı Akışkanlar 

Dinamiği ile İncelenmesi. Yüksek Lisans Tezi. Hava Harp Okulu Havacılık ve 

Uzay Teknolojileri Enstitüsü. İstanbul. 49s (2015). 

[8] Yusuf Berktaş Bir Sesaltı Rüzgâr Tüneli İçerisine Yerleştirilmiş Naca0012 Kanadının 

Sayısal Analizi Haziran 2012. 

[9] Fletcher, C. A. (2003). Computational Techniques For Fluid Dynamics 2: Specific 

Techniques For Different Flow Categories. New York: Springer-Verlag. 

[10] Özcan, O.A., Uçak Kanatların CFD Analizi. Yüksek Lisans Tezi. İstanbul Teknik 

Üniversitesi Fen Bilimleri Enstitüsü. İstanbul. 60s (2004). 

[11] FLUENT, ANSYS. Release 15.0. Theory Guide, November, 2013. 

[12] Okan, M. İki Boyutlu Bir Profil Etrafındaki Türbülanslı Akışın İncelenmesi. Doktora 

Tezi. İstanbul Teknik Üniversitesi, Fen Bilimleri Enstitüsü. İstanbul. 92s (2002). 

[13] Spalart. P.R. Ve Allmaras. S.R. “A One-Equation Turbulence Model For Aerodynamic 

Flows.” İn 30th Aerospace Sciences Meeting & Exhibit. AIAA-92-0439. Reno. 

NV. 6-9 Jan. 1992. 

https://www.linkedin.com/pulse/güneş-enerji-sistemleri-ges-fatih-soylemez


104 

 

 

[14] Hakan Telli Arka Gövde Eklentileri ile C-130’e Uçağı Basınç Sürüklemesinin 

Azaltılmasının Sayısal Olarak İncelenmesi Haziran 2014. 

[15] SÖYLEMEZ, İ., ARAÇLARDA AERODİNAMİK TASARIMIN ÖNEMİ VE ANSYS 

FLUENT İLE ANALİZİ. Bitirme Çalışması. Akdeniz Üniversitesi, Makine 

Mühendisliği Bölümü. 56s (2015). 

[16] Statik Analiz. (N.d.). (Erişim tarihi: 20.05.2019) http://www.cfdanaliz.com/statik-

analiz/statik-analiz/ . (2019) 

[17] Material Property Definitions. (N.d.). (Erişim tarihi: 01.06.2019) 

https://www.princeton.edu/~dynaflow/femgv/manuals/preansy/node25.htm . 

(1999) 

[18] Contact Definition- Contact Types in ansys. (Erişim tarihi: 15.05.2019) 

https://www.sharcnet.ca/Software/Ansys/16.2.3/en-

us/help/wb_sim/ds_Contact_Definition.html#ds_Contact_Types . (2015). 

[19] Static Structural Analysis. (Erişim tarihi: 25.04.2019) http://mguler.etu.edu.tr/WB-

Mech_120_Ch04_Static.pdf. (2009) 

[20] PİŞKİN, Ş., HESAPLAMALI BİLİM VE MÜHENDİSLİKTE ÖZEL KONULAR; 

MESH ÜRETİMİ. ÖDEV. İSTANBUL TEKNİK ÜNİVERSİTESİ, BİLİŞİM 

ENSTİTÜSÜ. 39s (2002). 

[21] Munoz, G. A. (n.d.). MESHING METHODS IN ANSYS WORKBENCH 16.0. (erişim 

tarihi: 27.05.2019) 

https://www.academia.edu/16969929/MESHING_METHODS_IN_ANSYS_WO

RKBENCH_16.0 . (2015). 

[22] Boundary Conditions for FEM. (Erişim tarihi: 15.05.2019) 

http://home.ku.edu.tr/~akabakcioglu/teaching/math506/fem.pdf 

[23] EN 1991-1-4: Eurocode 1: Actions on Structures - Part 1-4 ... www.phd.eng.br/wp-

content/uploads/2015/12/en.1991.1.4.2005.pdf. 

[24] Minimum Design Loads for Buildings and Other Structures. Published by American 

Society of Civil Engineers, 2013. 

[25] Simiu, Emil, and Emil Simiu. Design of Buildings for Wind: a Guide for ASCE 7-10 

Standard Users and Designers of Special Structures. Wiley, 2011. 

[26] Lift (force) facts for kids. (Erişim tarihi: 20.07.2019) https://kids.kiddle.co/Lift_(force) 

. 

  

http://www.cfdanaliz.com/statik-analiz/statik-analiz/
http://www.cfdanaliz.com/statik-analiz/statik-analiz/
https://www.princeton.edu/~dynaflow/femgv/manuals/preansy/node25.htm
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_sim/ds_Contact_Definition.html#ds_Contact_Types
https://www.sharcnet.ca/Software/Ansys/16.2.3/en-us/help/wb_sim/ds_Contact_Definition.html#ds_Contact_Types
http://mguler.etu.edu.tr/WB-Mech_120_Ch04_Static.pdf
http://mguler.etu.edu.tr/WB-Mech_120_Ch04_Static.pdf
https://www.academia.edu/16969929/MESHING_METHODS_IN_ANSYS_WORKBENCH_16.0
https://www.academia.edu/16969929/MESHING_METHODS_IN_ANSYS_WORKBENCH_16.0
http://home.ku.edu.tr/~akabakcioglu/teaching/math506/fem.pdf
http://www.phd.eng.br/wp-content/uploads/2015/12/en.1991.1.4.2005.pdf
http://www.phd.eng.br/wp-content/uploads/2015/12/en.1991.1.4.2005.pdf
https://kids.kiddle.co/Lift_(force)


105 

 

 

EKLER 

 

EK-A 10° eğimli arazi için HAD simülasyonu sonuçları 

A1.  Güneş panelleri üzerindeki basınç dağılımları 

A2.  Güneş panelleri üzerindeki akış çizgileri 

EK-B 20° eğimli arazi için HAD simülasyonu sonuçları 

B1. Güneş panelleri üzerindeki basınç dağılımları 

B2.  Güneş panelleri üzerindeki akış çizgileri 

EK-C 30° eğimli arazi için HAD simülasyonu sonuçları 

C1. Güneş panelleri üzerindeki basınç dağılımları 

C2.  Güneş panelleri üzerindeki akış çizgileri 

EK-D Doğrusal olmayan statik analizi raporu 
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EK-A1 𝟏𝟎° eğimli arazi için güneş panelleri üzerindeki basınç dağılımları 

 

Şekil A1.1 10°eğimli arazi; tek sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil A1.2 10° eğimli arazi; iki sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil A1.3 eğimli arazi; üç sıralı güneş paneller üzerindeki basınç dağılımı 

 

 

Şekil A1.4 10° eğimli arazi; dört sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil A1.5 10° eğimli arazi; beş sıralı güneş paneller üzerindeki basınç dağılımı 
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EK-A2 𝟏𝟎° eğimli arazi için güneş paneller üzerindeki akış çizgileri 

 

Şekil A2.1 10° eğimli arazi; tek sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil A2.2 10° eğimli arazi; iki sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil A2.3 10° eğimli arazi; üç sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil A2.4 10° eğimli arazi; dört sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil A2.5 10° eğimli arazi; beş sıralı güneş paneller üzerindeki akış çizgileri 
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EK-B1 𝟐𝟎° eğimli arazi için güneş paneller üzerindeki basınç dağılımı 

 

Şekil B1.1 20° eğimli arazi; tek sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil B1.2 20° eğimli arazi; iki sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil B1.3 20° eğimli arazi; üç sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil B1.4 20° eğimli arazi; dört sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil B1.5 20° eğimli arazi; beş sıralı güneş paneller üzerindeki basınç dağılımı 
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EK-B2 𝟐𝟎° eğimli arazi için güneş paneller üzerindeki akış çizgileri 

 

Şekil B2.1 20° eğimli arazi; tek sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil B2.2 20° eğimli arazi; iki sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil B2.3 20° eğimli arazi; üç sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil B2.4 20° eğimli arazi; dört sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil B2.5 20° eğimli arazi; beş sıralı güneş paneller üzerindeki akış çizgileri 
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EK-C1 𝟑𝟎° eğimli arazi için güneş paneller üzerindeki basınç dağılımı 

 

Şekil B2.6 30° eğimli arazi; tek sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil B2.7 30° eğimli arazi; iki sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil B2.8 30° eğimli arazi; üç sıralı güneş paneller üzerindeki basınç dağılımı 

 

Şekil B2.9 30° eğimli arazi; dört sıralı güneş paneller üzerindeki basınç dağılımı 
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Şekil B2.10 30° eğimli arazi; beş sıralı güneş paneller üzerindeki basınç dağılımı 
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EK-C2 𝟑𝟎° eğimli arazi için güneş paneller üzerindeki akış çizgileri 

 

Şekil C2.1 30° eğimli arazi; tek sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil C2.2 30° eğimli arazi; iki sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil C2.3 30° eğimli arazi; üç sıralı güneş paneller üzerindeki akış çizgileri 

 

Şekil C2.4 30° eğimli arazi; dört sıralı güneş paneller üzerindeki akış çizgileri 
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Şekil C2.5 30° eğimli arazi; beş sıralı güneş paneller üzerindeki akış çizgileri 
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FIGURE 4 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress 

 
TABLE 24 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress 

Time [s] Minimum 

[MPa] 

Maximum 

[MPa] 

0.1 1.1881e-005 4.2719 

0.2 2.3761e-005 8.5461 

0.3 3.5641e-005 12.823 

0.4 4.7521e-005 17.102 

0.5 5.9401e-005 21.383 

0.6 7.128e-005 25.667 

0.7 8.3159e-005 29.953 

0.8 9.5037e-005 34.242 

0.9 1.0692e-004 38.533 

1. 1.1879e-004 42.827 

FIGURE 5 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress > Figure 
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TABLE 28 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Total Strain critical 

profile 

Time [s] Minimum 

[mm/mm] 

Maximum 

[mm/mm] 

0.1 1.118e-007 2.1418e-005 

0.2 2.2363e-007 4.2849e-005 

0.3 3.3548e-007 6.4291e-005 

0.4 4.4737e-007 8.5745e-005 

0.5 5.5929e-007 1.0721e-004 

0.6 6.7123e-007 1.2869e-004 

0.7 7.8321e-007 1.5018e-004 

0.8 8.9521e-007 1.7168e-004 

0.9 1.0072e-006 1.932e-004 

1. 1.1193e-006 2.1472e-004 
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FIGURE 13 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Total Strain critical 

profile > Figure 

 
FIGURE 14 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress critical profile 
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TABLE 29 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress critical profile 

Time [s] Minimum 

[MPa] 

Maximum 

[MPa] 

0.1 6.5733e-003 4.2719 

0.2 1.3149e-002 8.5461 

0.3 1.9727e-002 12.823 

0.4 2.6306e-002 17.102 

0.5 3.2889e-002 21.383 

0.6 3.9473e-002 25.667 

0.7 4.606e-002 29.953 

0.8 5.2649e-002 34.242 

0.9 5.924e-002 38.533 

1. 6.5833e-002 42.827 

FIGURE 15 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Stress critical profile > 

Figure 
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FIGURE 16 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Plastic Strain 

 
TABLE 30 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Plastic Strain 

Time [s] Minimum 

[mm/mm] 

Maximum 

[mm/mm] 

0.1 0. 0. 

0.2     

0.3     

FIGURE 17 

Model (B4) > Static Structural (B5) > Solution (B6) > Equivalent Plastic Strain > Figure 
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FIGURE 18 

Model (B4) > Static Structural (B5) > Solution (B6) > Total Deformation structure 

 
TABLE 31 

Model (B4) > Static Structural (B5) > Solution (B6) > Total Deformation structure 

Time [s] Minimum 

[mm] 

Maximum 

[mm] 

0.1 0. 0.21478 

0.2   0.4296 

0.3   0.64448 

0.4   0.85942 

0.5   1.0744 

0.6   1.2894 

0.7   1.5045 

0.8   1.7197 

0.9   1.9349 

1.   2.1501 

FIGURE 19 

Model (B4) > Static Structural (B5) > Solution (B6) > Total Deformation structure > 

Figure 
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Chart 

FIGURE 20 

Model (B4) > Chart 
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TABLE 32 

Model (B4) > Chart 

Steps Time 

[s] 

Equivalent Total Strain critical 

profile (Max) [mm/mm] 

[C] Equivalent Stress critical 

profile (Max) [MPa] 

1 0.1 2.1418e-005 4.2719 

  0.2 4.2849e-005 8.5461 

  0.3 6.4291e-005 12.823 

  0.4 8.5745e-005 17.102 

  0.5 1.0721e-004 21.383 

  0.6 1.2869e-004 25.667 

  0.7 1.5018e-004 29.953 

  0.8 1.7168e-004 34.242 

  0.9 1.932e-004 38.533 

  1. 2.1472e-004 42.827 

Material Data  

Structural Steel NL 

TABLE 33 

Structural Steel NL > Constants 

Density 7.85e-006 kg mm^-3 

Specific Heat 4.34e+005 mJ kg^-1 C^-1 

TABLE 34 

Structural Steel NL > Isotropic Elasticity 

Temperature 

C 

Young's Modulus 

MPa 

Poisson's 

Ratio  

Bulk Modulus 

MPa 

Shear Modulus 

MPa 

  2.e+005 0.3 1.6667e+005 76923 

TABLE 35 

Structural Steel NL > Bilinear Isotropic Hardening 

Yield Strength 

MPa 

Tangent Modulus 

MPa 

Temperature 

C 

250 1450   

TABLE 36 

Structural Steel NL > Color 

Red  Green  Blue  

222 222 222 

Aluminum Alloy NL 
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TABLE 37 

Aluminum Alloy NL > Constants 

Density 2.77e-006 kg mm^-3 

Specific Heat 8.75e+005 mJ kg^-1 

C^-1 

TABLE 38 

Aluminum Alloy NL > Isotropic Elasticity 

Temperature 

C 

Young's Modulus 

MPa 

Poisson's 

Ratio  

Bulk Modulus 

MPa 

Shear Modulus 

MPa 

  71000 0.33 69608 26692 

TABLE 39 

Aluminum Alloy NL > Bilinear Isotropic Hardening 

Yield Strength 

MPa 

Tangent Modulus 

MPa 

Temperature 

C 

280 500   

TABLE 40 

Aluminum Alloy NL > Color 

Red  Green  Blue  

235 209 184 
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